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A computer is an electronic device that accepts data, performs operations, displays 

results, and stores the data or results as needed. It is a combination of hardware and software 

resources that integrate and provide various functionalities to the user. Hardware is the 

physical components of a computer, such as a processor, memory devices, monitor, 

keyboard, etc., while software is a set of programs or instructions that are required by the 

hardware resources to function properly. 

 

Components of a Computer 

Here are the main components of the computer: 

Learning Objectives 

 To understand the basic components of a computer system.  

 To differentiate between hardware and software.  

 To examine the functions of operating systems like DOS and Windows.  

 To study the basic operations and commands in DOS and Windows.  

 To understand the process and types of printing in computers. 



1. Input Unit: 

The input unit consists of input devices that are attached to the computer. These devices 

take input and convert it into binary language that the computer understands. Some of the 

common input devices are keyboard, mouse, joystick, scanner etc. 

 The Input Unit is formed by attaching one or more input devices to a computer. 

 A user input data and instructions through input devices such as a keyboard, mouse, etc. 

 The input unit is used to provide data to the processor for further processing. 

2. Central Processing Unit: 

The CPU (Central Processing Unit) is the brain of the computer because it controls 

everything the computer does. When you enter information using an input device, the CPU 

processes it. First, it fetches instructions from memory, then decodes them to understand what 

needs to be done. If needed, it retrieves data from memory or an input device. After that, the 

CPU executes the task and either stores the result or displays it on an output device. The CPU 

has three main parts: the Arithmetic Logic Unit (ALU), which handles calculations and logic; the 

Control Unit (CU), which directs operations; and Memory Registers, which store temporary data. 

A. Arithmetic and Logic Unit (ALU): The ALU, as its name suggests performs mathematical 

calculations and takes logical decisions. Arithmetic calculations include addition, subtraction, 

multiplication and division. Logical decisions involve the comparison of two data items to see 

which one is larger or smaller or equal.  

 Arithmetic Logical Unit is the main component of the CPU 

 It is the fundamental building block of the CPU. 

 Arithmetic and Logical Unit is a digital circuit that is used to perform arithmetic and 

logical operations. 

B. Control Unit: The Control unit coordinates and controls the data flow in and out of the CPU, 

and also controls all the operations of ALU, memory registers and also input/output units. It is 

also responsible for carrying out all the instructions stored in the program. It decodes the fetched 

instruction, interprets it and sends control signals to input/output devices until the required 

operation is done properly by ALU and memory. 

 The Control Unit is a component of the central processing unit of a computer that directs 

the operation of the processor. 



 It instructs the computer's memory, arithmetic and logic unit, and input and output 

devices on how to respond to the processor's instructions. 

 In order to execute the instructions, the components of a computer receive signals from 

the control unit. 

 It is also called the central nervous system or brain of the computer. 

C. Memory Registers: A register is a small, temporary memory inside the CPU. The processor 

uses it to store data that it is currently working on. Registers come in different sizes, such as 16-

bit, 32-bit, and 64-bit, and each has a specific role. Some store data, some store instructions, and 

others hold memory addresses. 

For example, the Accumulator (ACC) is an important register in the CPU. It holds one of 

the values used in calculations inside the Arithmetic and Logic Unit (ALU). 

Apart from registers, the internal memory (also called primary memory or main memory) 

is where data and instructions are stored temporarily while a program runs. This memory is 

called RAM (Random Access Memory). Every piece of data in RAM is stored at a unique 

location with an address, so the processor can access it quickly without searching the entire 

memory. Since RAM provides direct access to any data location, it is called Random Access 

Memory. 

 Memory Unit is the primary storage of the computer. 

 It stores both data and instructions. 

 Data and instructions are stored permanently in this unit so that they are available 

whenever required. 

3. Output Unit :  

The output unit consists of output devices that are attached to the computer. It converts 

the binary data coming from the CPU to human understandable form. The common output 

devices are monitor, printer, plotter, etc. 

 The output unit displays or prints the processed data in a user-friendly format. 

 The output unit is formed by attaching the output devices of a computer. 

 The output unit accepts the information from the CPU and displays it in a user-readable 

form. 



4. Motherboard: 

The motherboard is like the backbone of a computer, connecting all the important parts 

such as the CPU, memory, and storage. It also helps distribute power, transfer information, and 

connect devices like a mouse, keyboard, or monitor. If there is a problem with the 

motherboard, a computer technician may open the PC to check for any loose or damaged 

connections, such as corrosion. They may also inspect the power supply to ensure the computer 

is receiving electricity properly. 

5. Random Access Memory (RAM): 

RAM is the computer's short-term memory, where data is stored temporarily while 

programs are running. For example, when you open an app, it loads into RAM so the computer 

can access it quickly. A technician knows how to check what type of RAM a computer has, 

replace it if it's faulty, and fix issues with moving data in memory. They also understand 

different types of RAM and common problems that can affect it. Before repairing RAM, a 

technician might back up important files to prevent losing any important programs or 

documents. 

6. Power Supply Unit (PSU): 

The Power Supply Unit (PSU) gives electricity to all the parts of a computer. It usually 

connects the PC to a wall socket using a power cord. If there’s a problem, a technician may 

check by turning off the computer, unplugging the power cord, or trying a different cord or 

outlet to see if the issue is with the power supply. 

Characteristics of a Computer 

 Speed: Computers can perform millions of calculations per second. The computation 

speed is extremely fast. 

 Accuracy: Because computers operate on pre-programmed software, there is no space 

for human error. 

 Diligence: They can perform complex and long calculations at the same time and with 

the same accuracy. 

 Versatile: Computers are designed to be versatile. They can carry out multiple 

operations at the same time. 

 Storage: Computers can store a large amount of data/ instructions in its memory, 



Conclusion 

Computer have been there for many years and and its use have been spread widely. 

Three important component of Computer are Input Unit, CPU and Output Unit. But there are 

some other components like Memory Unit, Control unit and Arithmetic and Logical unit. 

Using this all components we can easily do complex operations. 

Computer Hardware 

 Computer hardware refers to the physical components of a computer that you can see 

and touch. These components work together to process input and deliver output based on user 

instructions. In this article, we’ll explore the different types of computer hardware, their 

functions, and how they interact to make your computer work. 

 

 



          

 

 

           

 

          



           

 

The computer has mainly has two major components: 

 Hardware 

 Software 

In this article, we only discuss computer hardware. 

 

What is a Computer Hardware 

Computer hardware is a physical device of computers that we can see and touch. E.g. 

Monitor, Central Processing Unit, Mouse, Joystick, etc. Using these devices, we can control 

computer operations like input and output. 

Computer Hardware Parts 

These hardware components are further divided into the following categories, which are: 

 Input Devices 

 Output Devices 

 Storage Devices 

 Hardware Components 

Input Devices 

 Input devices allow users to interact with a computer by entering data or commands. 

These devices convert the input into a format that the computer can process. 



        Now we discuss some input devices: 

 Keyboard: The most widely used input device, featuring 104 keys, including alphabetic, 

numeric, and function keys. Modern keyboards connect via Bluetooth, replacing 

traditional wired connections. 

 Mouse: A pointing device that controls the cursor on the screen. It features left, right, and 

middle buttons for selection and interaction. The sensor inside the mouse detects its 

movement speed, adjusting the cursor accordingly. 

 Scanner: Scans documents, images, and other media, converting them into digital 

formats for editing or processing, similar to a Xerox machine. 

 Trackball: A stationary pointing device with a ball that the user rotates to control the 

cursor, requiring less space than a traditional mouse. 

 Light Pen: A light-sensitive pen used to draw or select objects on a CRT screen by 

detecting raster patterns, offering a direct interaction with the display. 

 Microphone: Converts sound into electrical signals. It captures voice input for speech 

recognition and voice commands on the computer. 

 Optical Character Reader (OCR): Scans printed or handwritten text, converting it into 

digital data by detecting reflected light from the characters, similar to a scanner. 

 Bar Code Reader: Reads bar codes and converts them into digital data for processing. 

The bar code consists of light and dark lines that encode information. 

Output Devices 

 Output devices display the results of tasks given to the computer in a human-

readable form. Let’s discuss some common output devices: 

 Monitor: The main output device. It is also called VDU(visual display unit) and it looks 

like a TV screen. The Monitor displays the information from the computer. It is used to 

display text, video, images, etc. 

 Printer: A printer is an output device that transfers data from the computer in a printed 

format by using text or images on paper. There are both coloured and black & white 

printers. Further, there are also different types of printers, like Laser Printer, Dot-matrix 

printers, and Inkjet printers. 



 Plotter: It is similar to a printer but potters are large. A plotter is used to generate large 

drawings, architectural blueprints, etc. on paper and these are high-quality images and 

drawings and large. 

 Speakers: It is a very common output device and it gives sound as an output. The speaker 

is generally used to play music or anything having sound. 

Storage Devices 

 Some devices are used for storage purposes and are known as secondary storage 

devices. Some of them are discussed below: 

1. CD (Compact disc): A CD is circular and made up of thin platted glass and plastic 

polycarbonate material. It has a storage capacity of 600 MB to 700 MB of data. It has a standard 

size of 12 cm with a hole in the centre of about 1.5 cm and 1.2 mm in thickness. There are 3 

types of CDs, which are: 

 CD-ROM (CD - Read Only Memory): Contents of this type of CD cannot be erased by 

the user. Only the publisher is allowed to access the data imprinted on this CD. CD-ROM 

is used for commercial purposes like for a music album or any application package by a 

software company. 

 CD-R (CD-Recordable): In this, content or data can be stored once. After that, they can 

be read many times but the data or content cannot be rewritten or erased. (Kind of one-

time use) 

 CD-RW(CD-Rewritable): As the name suggests, this type of CD is used to rewrite the 

content or erase previous content and again write new content many times. 

2. DVD (Digital Video/Versatile Disc): A DVD is the same as a CD but with some more 

features. A DVD comes in single and dual-layer formats. It has much greater storage capacity in 

comparison to CD. The storage capacity of a DVD with a one-sided single layer is - 4.7 GB, one-

sided double layer - 8.5 GB, double-sided single layer - 9.4 GB, and double-sided double layer - 

17 GB. There are also some types of DVDs, which are : 

 DVD-ROM: In this type, the contents of the DVD cannot be written on or erased by the 

user. DVD ROM is used for applications and databases for distributing them in large 

amounts. 



 DVD-R / DVD+R: DVD-R (DVD minus R) and DVD+R (DVD plus R) are two different 

kinds of discs and they are once recordableformatst. Also, they have no difference 

virtually. 

 DVD-RW / DVD+RW: This is a kind of rewritable disc and it allows up to 1,000 

rewrites. 

 DVD-RAM: DVD RAM is accessed like a hard disk. It provides high data security and 

storage capacity. This is a kind of rewritable disc and it allows up to 1,00,000 rewrites. 

3. Hard DiskAtheAn hard disk is a non-volatile storage device that uses its read/write heads to 

store digital data on the magnetic surface of a rigid plate. It is generally 3.5 inches in size for 

desktops and 2.5 inches in size for laptops. A hard disk can be classified further into 3 types, 

which are: 

 Internal Hard Disk: It has a common storage capacity stated as GB or TB. A system case 

or cabinet is the place where it is located. It can perform faster operations and its storage 

is fixed. It is mainly used to store large data files and programs. 

 Internal Cartridges: The Internal hard disk can't be removed from the system cabinet 

easily. To resolve this problem Internal Cartridges are introduced. So, Internal cartridges 

make it easy to remove CDs. It has a storage capacity of 2 GB to 160 GB. It is used as an 

alternative to an internal hard disk. 

 Hard Disk Packs are used by organizations such as banks and government sector 

organizations to store large amounts of data. They have a storage capacity of PB (peta 

bytes). 

Hardware Components 

Some important hardware devices known as the internal components are discussed below:  

1. CPU (Central Processing Unit) 

The CPU is also known as the heart of the computer. It consists of three units, generally 

known as the control unit, the Arithmetic Logical Unit (ALU), and the memory unit. Below is 

the block diagram of the CPU is given: 

As shown in the diagram input is given to the CPU through input devices. This input 

goes to memory and the control unit gets instructions from memory. The control unit now 

decides what to do with the input or instructions and transfers it to ALU. Now, ALU performs 

various operations like addition, subtraction, multiplication, division, logical operations, etc. 

https://www.geeksforgeeks.org/introduction-of-alu-and-data-path/
https://www.geeksforgeeks.org/introduction-to-memory-and-memory-units/


After that, the final result gets stored in memory and finally passed to output devices to give 

the output. So, this is how the CPU works. 

2. Motherboard 

It is the main circuit board inside a computer and it contains most of the electronic components 

together. All the components of the computer are directly or indirectly connected to the 

motherboard. It includes RAM slots, controllers, system chipsets, etc.  

3. RAM (Random Access Memory) 

It is also known as temporary or volatile memory. It holds the program and data, which 

are currently in process or processing. All the data is erased as soon as the computer is turned 

off or in case of a power failure. Data stored in this memory can be changed. There are two 

types of RAM:- 

1. SRAM (Static RAM): SRAM consists of a flip-flop using a transistor or Mosfet (MOS). 

It is fast and has less access time. In this refreshing circuits are not required. But it is 

costly and requires more space. E.g. cache memory. 

2. DRAM (Dynamic RAM): DRAM consists of capacitors and the data is stored in the 

form of capacitors. Capacitors charge when data is 1 and don't charge if data is 0. It 

requires refreshing circuits, as leakage of current in the capacitor can occur, so they 

need to be refreshed to the data. It is slower and has a higher access time. It is cheaper 

in comparison with SRAM. E.g. Main memory. 

4. Video Graphics Array Port 

A video input commonly used on computer monitors is called a video graphics array 

(VGA) port. Verifying that there isn't a loose connection, a damaged cable, or a broken display 

is one step in troubleshooting a VGA port. Compressed air can also be sprayed inside the VGA 

port by a computer expert to make sure it's dust-free. 

5. Power Supply 

All of a computer system's parts are powered by a power source. Typically, a power 

cord is used to connect a computer tower to an electrical outlet. By turning off the computer, 

unplugging and separating the power supply cord, or trying a different cord or socket, a 

technician can diagnose the power supply. 

 

 



6. Cooling Fan 

A computer's system to prevent overheating uses cooling fans. To aid customers who 

use their computers intensively, such as when streaming video or playing games, many 

computers contain more than one cooling fan. If a user detects their computer overheating, a 

computer expert might need to repair the cooling fan. The blades may be examined for any 

damage and cleared of any foreign objects. A technician's standard method of troubleshooting 

may involve replacing computer fans. 

7. Hard Drive 

On a computer system, files, programs, and other types of information are stored on 

hard drives, which are data storage devices. They utilise hard drives, which are magnetically 

coated discs used to store digital versions of information. A computer technician can suspect a 

corrupt hard disk when a hard drive dies. 

Relationship Between Computer Hardware and Software 

  

    Category                    Hardware                                Software 

Definition Physical devices that perform 

tasks 

Programs or applications that run on 

hardware 

Examples CPU, RAM, Hard Drive, 

Monitor, Keyboard 

Operating Systems, Applications, 

Utilities 

Purpose Executes and stores data 

physically 

Processes data and provides user 

interface 

Dependence Independent of software, but 

relies on it to function 

Requires hardware to operate 

Interaction Direct interaction with the user 

or system 

Indirect interaction, using hardware 

as a platform 

Examples of 

Interaction 

Input / .Output devices like 

keyboard, mouse 

Word processors, video editors, web 

browsers 

Cost Generally higher initial cost Often lower initial cost 

Installation Requires physical setup or 

installation 

Installed via software package or 

online 

 



 

Software and its Types 

 Software is a collection of instructions, data, or computer programs that are used to run 

machines and carry out particular activities. It is the antithesis of hardware, which refers to a 

computer's external components. A device's running programs, scripts, and applications are 

collectively referred to as "software" in this context. 

What is a Software? 

In a computer system, the software is basically a set of instructions or commands that 

tell a computer what to do. In other words, the software is a computer program that provides a 

set of instructions to execute a user’s commands and tell the computer what to do. For example 

like MS-Word, MS-Excel, PowerPoint, etc. 

Types of Software 

It is a collection of data that is given to the computer to complete a particular task. The 

chart below describes the types of software: 

                      

Above is the diagram of types of software. Now we will briefly describe each type and its 

subtypes: 

 

1. System Software 

 Operating System 

 Language Processor 



 Device Driver 

2. Application Software 

 General Purpose Software 

 Customize Software 

 Utility Software 

System Software 

System software is software that directly operates the computer hardware and provides 

the basic functionality to the users as well as to the other software to operate smoothly. Or in 

other words, system software basically controls a computer’s internal functioning and also 

controls hardware devices such as monitors, printers, and storage devices, etc. It is like an 

interface between hardware and user applications, it helps them to communicate with each 

other because hardware understands machine language(i.e. 1 or 0) whereas user applications 

are work in human-readable languages like English, Hindi, German, etc. so system software 

converts the human-readable language into machine language and vice versa. 

 Types of System Software 

It has two subtypes which are: 

1. Operating System: It is the main program of a computer system. When the computer 

system on it is the first software that loads into the computer's memory. Basically, it 

manages all the resources such as computer memory, CPU, printer, hard disk, etc., and 

provides an interface to the user, which helps the user to interact with the computer 

system. It also provides various services to other computer software. Examples of 

operating systems are Linux, Apple macOS, Microsoft Windows, etc. 

2. Language Processor: As we know that system software converts the human-readable 

language into a machine language and vice versa. So, the conversion is done by the 

language processor. It converts programs written in high-level programming languages 

like Java, C, C++, Python, etc (known as source code), into sets of instructions that are 

easily readable by machines(known as object code or machine code). 

3. Device Driver: A device driver is a program or software that controls a device and 

helps that device to perform its functions. Every device like a printer, mouse, modem, 

etc. needs a driver to connect with the computer system eternally. So, when you 

https://www.geeksforgeeks.org/system-software/
https://www.geeksforgeeks.org/computer-hardware/
https://www.geeksforgeeks.org/device-driver-and-its-purpose/
https://www.geeksforgeeks.org/how-to-install-a-modem/


connect a new device with your computer system, first you need to install the driver of 

that device so that your operating system knows how to control or manage that device.  

Features of System Software 

Let us discuss some of the features of System Software: 

 System Software is closer to the computer system. 

 System Software is written in a low-level language in general. 

 System software is difficult to design and understand. 

 System software is fast in speed (working speed). 

 System software is less interactive for the users in comparison to application software. 

Application Software  

Software that performs special functions or provides functions that are much more than 

the basic operation of the computer is known as application software. Or in other words, 

application software is designed to perform a specific task for end-users. It is a product or a 

program that is designed only to fulfill end-users' requirements. It includes word 

processors, spreadsheets, database management, inventory, payroll programs, etc. 

Types of Application Software 

There are different types of application software and those are: 

1. General Purpose Software: This type of application software is used for a variety of 

tasks and it is not limited to performing a specific task only. For example, MS-Word, 

MS-Excel, PowerPoint, etc. 

2. Customized Software: This type of application software is used or designed to perform 

specific tasks or functions or designed for specific organizations. For example, railway 

reservation system, airline reservation system, invoice management system, etc.  

3. Utility Software: This type of application software is used to support the computer 

infrastructure. It is designed to analyze, configure, optimize and maintains the system, 

and take care of its requirements as well. For example, antivirus, disk fragmenter, 

memory tester, disk repair, disk cleaners, registry cleaners, disk space analyzer, etc.  

Features of Application Software 

Let us discuss some of the features of Application Software: 

 An important feature of application software is it performs more specialized tasks like 

word processing, spreadsheets, email, etc. 

https://www.geeksforgeeks.org/what-is-application-software/
https://www.geeksforgeeks.org/introduction-to-excel-spreadsheet/


 Mostly, the size of the software is big, so it requires more storage space. 

 Application software is more interactive for the users, so it is easy to use and design. 

 The application software is easy to design and understand. 

 Application software is written in a high-level language in general. 

Difference Between System Software and Application Software 

Now, let us discuss some difference between system software and application software: 

                     System Software                      Application Software 

It is designed to manage the resources of 

the computer system, like memory and 

process management, etc. 

It is designed to fulfill the requirements of 

the user for performing specific tasks. 

Written in a low-level language. Written in a high-level language. 

Less interactive for the users. More interactive for the users. 

System software plays vital role for the 

effective functioning of a system. 

Application software is not so important 

for the functioning of the system, as it is 

task specific. 

It is independent of the application 

software to run. 

It needs system software to run. 

 

DOS and Windows 

DOS and Windows square measure the various varieties of Operating Systems. DOS 

stands for Disk Operating System. It is a smaller amount probably employed in the current 

state of affairs whereas windows may be a wide used in operation system. It consumes less 

memory and power than windows. 

Features of DOS: 

 Command Line Interface: DOS is primarily a command-line operating system, which 

means that users must type commands to perform operations. 

 Small Size: DOS is a very small operating system, which makes it easy to install on 

computers with limited storage space. 

 Low Resource Usage: DOS has a very small memory footprint, which makes it ideal for 

use on computers with limited memory. 



 Compatibility: Many old applications and games were designed to run on DOS, and it 

can be used to run them even on modern systems. 

Window has no full form but it is widely used operating system than DOS operating 

system. It consumes more memory and power than DOS operating system. DOS and 

Windows square measure principally differentiated by the actual fact that DOS may be 

a single tasking, single user, interface primarily based OS developed within the year of 

1979. On the opposite hand, all the windows version square measure multitasking, 

multiuser and graphical user interface primarily based OS. 

Features of Windows: 

 Graphical User Interface: Windows has a graphical user interface (GUI), which means 

that users can interact with the operating system using a mouse and a graphical 

interface. 

 Multitasking: Windows allows multiple applications to run simultaneously, with each 

application running in its own window. 

 Compatibility: Windows is compatible with a wide range of hardware and software, 

making it a versatile operating system. 

 Plug and Play: Windows supports plug and play, which means that hardware can be 

connected to a computer and automatically recognized and configured by the operating 

system. 

Similarities between DOS and Windows: 

 Command Prompt: While Windows has a graphical user interface, it still has a 

command prompt that allows users to access the command line interface. 

 File System: Both DOS and Windows use the File Allocation Table (FAT) file system. 

 Applications: Many applications that were designed to run on DOS can also run on 

Windows, either natively or with the help of an emulator. 

 Compatibility: Both DOS and Windows have a high degree of compatibility with a 

wide range of hardware and software. 

 

 

 

 



 

 

Let's see the difference between DOS and Windows: 

S. NO                              DOS            WINDOW 

1 DOS is single tasking operating 

system. 

While windows are multitasking operating 

systems. 

2 It consumes low power. While windows consume high power. 

3 It consumes less memory in 

comparison of windows. 

While it consumes more memory. 

4 DOS does not support networking. While window supports networking. 

5 DOS is complex in terms of using. Whereas it is simple for using. 

6 DOS does not share time. While window can share time. 

7 DOS is a command line operating 

system. 

Whereas windows are the graphical 

operating systems. 

8 DOS operating system is less 

preferred than windows. 

While windows are more preferred by the 

users in comparison of DOS. 

9 In DOS operating system multimedia 

is not supported such as: Games, 

movies, songs etc. 

While windows support multimedia such as: 

Games, movies, songs etc. 

10 In DOS operation systems, operation 
are performed speedily than windows 

OS. 

While in windows OS, operation are 
performed slowly than DOS OS. 

11 There is only one window opened at a 
time in DOS. 

While in windows, multiple windows can be 
opened at a time. 

12 DOS does not need any pointing 

devices. 

While Windows uses various pointing 

devices such as light pen, mouse, etc. 

13 DOS is not widely used in computer 
systems now-a-days. 

While Windows is used now-a-days in 
computer systems. 

14 DOS is free of cost. While original version of Windows is 

expensive. 

Conclusion: 

While both DOS and Windows are operating systems used in personal computing, they 

have significant differences in terms of user interface, multitasking, hardware support, file 

system, and application support. Windows is a more modern and feature-rich operating system 

compared to DOS and is better suited for modern computing devices. However, DOS is still 

used today in some legacy systems and applications that require a command-line interface. 

What is a Printer? 

A printer is a device that accepts text and graphics output from a computer, and it 

transfers this information to paper, sheets. Printers can print any information that has been 



passed to them, whether it be Text, Numbers or Images. It depends on the type of printer that 

determines what quality or colour the printed matter will be. 

              

 

History of Printer 

In 1822, Charles Babbage introduced the first mechanical printer with his Difference 

Engine. Inkjet printers were invented in the 1950s but became practical in the 1970s, with 

companies like Epson, Canon, and HP leading the way. In the early 1970s, Gary Stark weather 

at Xerox created the first laser printer by modifying a copier. This led to the HP LaserJet in 

1984, making laser printers more affordable. Apple’s 1985 LaserWriter introduced PostScript 

technology to the market. In 1984, Chuck Hull demonstrated the first 3d printer, while IBM 

introduced the first dot matrix printer in 1957. 

 Type of Printers 

Depending upon the printing methods and the quality of images produced, printers are of two 

major types:  

1. Impact Printers 

2. Non-Impact Printers 

Impact Printers 

This type of printer works with paper via direct contact with an ink ribbon. It has 

similar mechanisms to of typewriter. 



      

 

Examples of Impact Printers are Daisy-Wheel Printers, Dot-Matrix Printers, Line Printers, etc. 

1. Daisy-Wheel Printers: Daisy wheel printing is a mechanical impact printing technology. It 

is called a daisy-wheel because its printing mechanism looks like a daisy. Its speed is usually 

25-50 characters per second.  

2. Dot-Matrix Printers: The Dot-Matrix printers use 9 to 24-pin print heads depending upon 

the quality of print required. 24-pin printers produce more clarity than 9 9-pin dot-matrix 

printer. More number of pins results in more clarity. Usually inexpensive, and speed ranges 

between 100 and 550 characters per second. 

3. Line Printers: Line Printers (also called line-at-a-time printers), as the name suggests it can 

print a whole line at once. Speed ranges somewhere between 1,000 to 6,000 lines per minute. 

Non-Impact Printers 

Non-Impact Printers do not need to touch the ink ribbon to print the documents. 

Maintenance of Non-Impact printers is easier than Impact printers. 



        

 Examples of non-impact printers are Inkjet printers, Laser Printers and etc. 

1. Inkjet Printers: The inkjet printers are the most common and widely used in both 

professional and domestic settings. It is popular due to its numerous advantages and very few 

drawbacks. 

Advantages of Inkjet Printers 

 Capable of printing highly detailed and photo-elastic prints. 

 Small footprints 

 Environment friendly 

 Compact Design 

 Versatile  

 Best Picture and Image quality 

Disadvantages of Inkjet Printers 

 Higher cost per page than laser printers 

 Less Reliable 

 Slow print speed 

2. Laser Printers: Laser Printers were developed by Xerox in the 1960s. The majority of laser 

printers use light, photoreceptor belts, and photosensitive drums.  During printing, the laser 

will scan the page line by line. The most accepted writing method is black and white lasers, 

which print content in black text. 

Advantages of Laser Printers 

 Cost-effective than inkjet printers. 

 High print speed. 



 Expandable with paper trays, finishes, etc 

 High paper capacity. 

Disadvantages of Laser Printers 

 Large footprints. 

 High voltage usage. 

3. LED Printers: LED Printers are quite similar to Laser Printers, but they use LED instead of 

laser to create pictures/images. LED printers are considered more efficient and reliable than 

laser printers.   

Advantages of LED Printers 

 Efficient 

 Reliable 

 Cheaper than laser printers. 

Difference Between Impact Printer and Non-Impact Printer 

The main difference between impact printers and non-impact printers is how they print on 

paper: 

Feature Impact Printer Non-Impact Printer 

How it works Hits the paper with pins or hammers Uses heat or ink to print 

Noise Loud Quiet 

Print Quality Lower quality (dots) High quality (clear text and 

pictures) 

Speed  Slower Faster 

Cost Cheaper More expensive 

Print Types Can print on multiple sheets Prints on one sheet at a time 

Maintenance Needs more care and repairs Easier to maintain 

Examples Dot matrix printers Inkjet or Laser printers 

 

Qualities to Check Before Buying a Printer 

 Color Capability: Many current printers can produce colour prints as well as black-and-

white ones. Colour printing costs more because it requires multiple ink or toner 

supplies, usually in black, cyan, magenta, and yellow shades. 



 Print Clarity: The detail and clarity of printed text or images are measured by how 

many dots fit into an inch (dpi). A basic printer often delivers enough sharpness with a 

600 dpi rating. 

 Printing Speed: For those who need to print frequently, how fast the printer works 

matters. Basic models may handle only 3–6 pages every minute, while high-end 

machines can print much faster. 

 Internal Storage: Printers usually come with a small built-in memory space, often 

between 2 to 16 MB. Extra memory can be added, which is helpful when dealing with 

pages full of large graphics or images. 

Conclusion 

A printer is a adaptable electronic device that produces physical copies of digital 

documents, images, or graphics. It is used in both personal and professional settings, offering 

various printing technologies such as inkjet, laser, and thermal printing. Printers have changed 

over time, becoming faster, more efficient, and capable of producing high-quality outputs. 

They are essential for a wide range of tasks, from home office use to large-scale commercial 

printing, making them an indispensable tool in today’s digital age. 

     

 

 

 

 

 

 

 

 

           

 

 

 

 

 

Course Outcomes 

CO1: Explain the components of a computer system. 

CO2: Distinguish between hardware and software. 

CO3: Describe the features of operating systems like DOS and Windows. 

CO4: Analyze basic computer operations and commands. 

CO5: Examine the process and types of printing in computers. 

Programme Outcome 

PO: To develop students’ basic knowledge of computer systems 

and operations, enabling effective use of technology in academic 

and professional work. 



S. No Question (5 Mark) LOCF Mapping 

1. Explain the components of a computer system. CO2 PO1 K2 

2. Discuss the differences between hardware and 

software. 

CO4 PO1 K4 

3. Analyze the functions of operating systems like DOS 

and Windows. 

CO4 PO1 K4 

4. Explain the features of DOS operating system. CO2 PO1 K2 

5. Discuss the features of Windows operating system. CO2 PO1 K2 

 

S. No Question (8 Mark) LOCF Mapping 

1. Examine the different types of input and output 

devices. 

CO4 PO1 K4 

2. Explain the process of printing in computers. CO2 PO1 K2 

3. Discuss the types of printers and their uses. CO2 PO1 K2 

4. Analyze the role of software in computer functioning. CO4 PO1 K4 

5. Evaluate the importance of operating systems in 

computers. 

CO5 PO1 K5 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



UNIT II 

Creating a New Document – Open and Close Document – Delete a File – Save a File – 

Cut, Copy and Paste 

 

 

 

 

 

 

 

 

 

Creating a New Document 

 Microsoft Word or MS-Word is a Fantastic word processing program that has many 

features, and it is very user-friendly and interactive for the user. It allows the user to create 

documents such as letters, articles, etc. It is easy to work with because of the vast features 

provided by MS-Word. 

Opening the Document 

Opening a document is very basic, and it is a kind of the first step for a user to start 

with MS Word. It is obvious that to make any document or to modify any document, We have 

to open that document first. So, in this article, we will learn how to open a document in MS 

Word. For this, we will learn step by step the whole process of opening a document with the 

help of sample images and also necessary instruction: 

Method 1: Opening Default Document 

When we open MS-Word, we find that a blank page with a default name ("Document1" 

generally) is opened.  

Step 1: First Open MS-Word on your PC. 

Step 2: By default, a new document with a blank page is already opened and the screen looks 

like the below image. 

Learning Objectives 

 To understand how to create a new document in a computer system.  

 To learn how to open and close documents efficiently.  

 To study file management operations such as saving and deleting files.  

 To understand editing functions like cut, copy, and paste.  

 To develop basic computer handling skills for document processing. 



            

 

Method 2: Opening a document of your choice 

We use MS-Word to create different types of documents. So, a situation may come 

where we need to open a document i.e. already existed, and we need to modify that document. 

So, for this follow the steps below: 

Step 1: First Open MS-Word on your PC. So, the screen looks like the below image: 

 

Step 2: Now, above there is a tab called "File"(Shown in the image below). 



 

Step 3: Now, Click on the "File" tab and the file tab will open and looks like the below 

image. 

 

 

Step 4: Now, on the left-hand side of the page or screen there are many options. Select "Open" 

to open a document of your choice. 



                                            

Step 5: Now, open the document of your choice, by double-clicking on the file of your choice. 

Step 6: Now, the opened document will look something like the below image. 

   

Step 7: You have successfully opened the document of your choice. 

Method 3: Opening a New document 

This is a condition or situation when a user is already working in MS-Word and wants a new 

document. So, let us see how it can be done step by step: 



Step 1: First open MS-Word on your PC. 

Step 2: Now, Open the document in which you would work.(like in the below image) 

 

Step 3: Now, You want to open a fresh new document to work in. 

Step 4: Now, above there is a tab called "File"(Shown in the image below). 

 

Step 5: Now, Click on the "File" tab and the file tab will open and looks like the below 

image. 



 

Step 6: Now, on the left-hand side of the page or screen there are many options. Select "New" 

to open a fresh new document. 

                                               

Step 7: Now, After clicking on "New". Select a Template from "available Template" option. 

(marked in the image below) 



   

Step 8: After selecting a template (in this example blank is selected). Click on the "create" 

option, which is present on the right side of the screen. 



 

Step 9: You have successfully created the new document or opened a new document. 

 

So, in all these ways we can open a document in MS-Word. 



Open and Close Document 

MS Word or Microsoft Word is a software used to create documents such as reports, 

PDFs, pictured-document, assignments, etc. Microsoft provides features like Adding Images, 

Adding Visual effects, adding charts and graphs, etc. to a word file.  

Closing a Document 

Closing of a document after the desired work to it is done or there is a need for a break 

in between completing the content of the file, is a very important task, as it helps to prevent the 

undesired changes to occur to the content. Closing a document doesn't necessarily mean that 

there is a need to close the entire MS Word, one can easily close a specific file that is currently 

open in the MS Word and then continue working with another file. There are multiple methods 

to close a document/file in MS Word. 

 Method 1: Using the File Menu 

MS Word provides a specific option to close the Word Document after the work to it is done. 

Following are the steps to do the same: 

Step 1: Click on the File Menu Tab. 

 

Step 2: Click on the Close button provided in the options under File Menu. 



       

 

Step 3: If the file is not saved, a pop-up will arise asking you to save the file. You can choose 

either to Save the file and perform the save operation or if there is no need to save the File, 

choose the Don't Save button. 

 



Step 4: In case, the Close button is pressed by mistake, MS Word gives you a second option to 

cancel the close operation. 

 

Note: These options provided in the pop-up menu will only arise for the Unsaved Files. Saved 

files will close directly. 

Method 2: Using the Window Close button 

If you do not want to use the File Menu tab, then MS Word document can also be 

closed by the Close button provided in the File Window.  

Step 1: Click on the 'X' button provided in the Top-right corner of the File Window. 

 

Step 2: If the file is not saved, then a pop-up will arise to either Save the file or Don't Save and 

Close the file as it is. 

 



 

Step 3: If the 'X' button is pressed by mistake, then the Cancel button can be used from the 

pop-up to avoid the file from getting closed. 

 

Method 3: Using the Shortcut Keys 

If you don't want to use the mouse and want to close the file, then use the shortcut keys that are 

provided by MS Word to close a file. 



 

Step 1: Press the 'CTRL + F4' keys simultaneously to close the Word File. 

Step 2: If the File is an existing file and the changes are unsaved, then you can press 'CTRL + 

S' before performing Step 1. 

Delete a File 

How to Delete a Microsoft Word Document 

Delete a Document in Microsoft Word 

 Open Microsoft Word  > Select the "File" tab > Choose 'Open'  

 Select the File > Right Click the Document > Select Delete 

 Confirm Yes 

Microsoft Word, a powerful word processing tool, simplifies the creation and editing of 

documents. However, managing your documents efficiently is equally crucial. Whether you're 

dealing with obsolete files, duplicates, or simply need to free up space, the process of deleting 

a document in Word is just as straightforward as creating one. In this article, we'll guide you 

through the easy steps to swiftly declutter your digital workspace and regain valuable memory 

space. 

How to Delete Documents from Microsoft Word 

Step 1: Open Microsoft Office Word 

On your computer desktop, you can access the office suite and locate Microsoft Word 

to launch the application. 

 



Step 2: Select File Tab 

In your document access and select the "File tab" in the top-left corner once the window has 

opened. As you click on it a drop down menu will appear consisting of different options. 

 

Step 3: Click on Open 

Among different options given, Choose 'Open' from the drop-down menu to access your files. 

 

Step 4: Select the Location of the Document 



After clicking on open you need to go to the precise location of the file you want to delete by 

navigating there using any of the given approaches as shown in the below figure. 

 

Step 5: Select Document and Right Click to choose Delete 

Find the file you want to delete and then press the 'Delete' button from the menu by 

right-clicking it. 

Note: The file that you deleted will go into the trash bin, from where you can recycle it again 

as per your need. 

 



How to Delete a Word Document on Mac 

Step 1: Go to Finder. 

To delete a Word document, you must locate the MS word document within Finder. 

Step 2: Locate the Word document you want to delete, then right-click it. 

Step 3: Select Move to Trash 

Conclusion 

We have learned how to delete a doc in word easily on your desktop and mobile device. 

This is easy to do as at first you have to open the Word application then click on the file tab, 

select the location of the file to be deleted from where you can delete the required file. 

Alternatively, you can also delete the doc by simply going to the file explorer, browse to the 

file location and select the doc to be deleted. Deleting the Doc in Word on Mobile Device is 

also quite a simple process and can be done by Search for the file which is required to be 

deleted in the Files Manager and then Search for the file, long press the file and then select 

delete tab and then give the final confirmation. The file will get moved to the trash bin and can 

be deleted permanently from there.    

Save a File 

Save a Document in Microsoft Word   

 MS Word or Microsoft Word is a software used to create documents such as reports, 

PDFs, pictured-document, assignments, etc. Microsoft provides features like Adding Images, 

Adding Visual effects, adding charts and graphs, etc. to a Word file.  

Saving a Document 

Saving a document is a very important step that is to be executed right after the addition 

of some content in a document. This is done to prevent the loss of data that might occur 

because of power cuts or system failure. There are multiple ways provided by MS Word to 

save a file or a document with/without a name specified by the user.    

Method 1: Saving a file with File Menu 

To save a document using the options provided by MS Word in its File menu, go through the 

following steps: 

 

 

 



Step 1: Click on the File Menu. 

 

Step 2: Go to the Save or Save As button provided. 

 

Step 3: Select the location where you want the file to be saved. 



 

Step 4: Provide a name to the file or use the default one. 

 

Step 5: Click on the Save button 

 



Method 2: Using the Keyboard Shortcut Keys 

MS Word allows us to use the shortcut keys, in case we don't want to go through the 

process of clicking on File Menu and selecting Save. Steps to do the same are given below: 

Step 1: Use the keys 'CTRL + S' to enter the Save As menu after the creation of a new 

file. 

Step 2: Follow the steps from Step 3-Step 5 provided in the method 1. 

Note: This shortcut will only allow to save the file with a new name only once, rest all the 

times, it will just overwrite the existing file. 

Saving a File with New Name: 

To save an existing file with a new name, Save As will be used. Save button will just 

overwrite the existing file with the same name. 

 Method 3: Saving a Document while Closing 

Sometimes, we may forget to save our file after making changes to its content and then 

try to close the file, MS Word will prevent the user from doing so, by providing a pop-up to 

Save the file while being closed. 

Step 1: Add content to a newly created file or an existing file. 

 

Step 2: Close the file with the Close button provided on the Top-right corner of the 

Window. 



 

Step 3: Choose the option of Save provided in the pop-up. 

 

Step 4: Further follow the steps to save the file as explained in the previous 

methods. 

Note: This option is used just to prevent the content from getting lost and is not a 

recommended method. Use the other two methods to save the file. 

Method 4: Saving a file with other extensions/format. 

From the Save As section we can also save our word file into different formats if 

necessary. It might not be a word document; it can be PDF, XPS Document, older version of 

office document etc. While saving our file after clicking Save As. we can select the format 

from the drop down menu to which we would like to save / convert our word file. 

Cut, Copy and Paste 

How to Cut, Copy and Paste on Windows 

 If you use regularly use a Windows PC, laptop, or any other device, you probably know 

how essential it is to cut, copy, and paste content. These actions are some of the most basic and 

time-saving tools to handle text, files, and images on your computer. 

In this guide, you will learn some of the quick methods to cut, copy, and paste, from 

keyboard shortcuts to Clipboard History and beyond. Whether you're on a desktop or laptop, 



these tricks will make your life much easier. Let’s walk through how to cut, copy, and paste in 

the easiest way possible. 

 

 

How to Cut, Copy, and Paste on Windows PC and Laptop: 8 Easy Methods 

Performing the cut, copy, and paste on laptop is one of the most basic task that every 

user performs in their day-to-day task. Below are the best 8 methods to perform this action, 

let's find out: 

1. Using Keyboard Shortcuts 

Keyboard shortcuts are one of the fastest and most efficient ways to copy, cut, and paste on 

Windows, working across both Windows 10 and Windows 11. Here are the common shortcuts: 

Copy: Select items and press Ctrl + C to copy to the clipboard. 

Cut: Select items and press Ctrl + X to cut (removes from the original location). 

Paste: Go to your destination and press Ctrl + V to paste. 

Paste as plain text (no formatting): Ctrl + Shift + V. 



 

2. Using Mouse (Right-Click) 

This method is helpful for users who prefer working with the mouse rather than keyboard 

shortcuts. Both Windows 10 and Windows 11 support cut, copy, and paste through the right-

click context menu: 

 Select the content you wish to cut or copy. 

 Right-click the selected item. 

 Choose Copy or Cut from the context menu. 

 Paste: Right-click in the destination and select Paste from the menu. 

 



Note: This method is especially helpful when you’re working with files and folders on your 

laptop or Windows desktop. 

Copy and Paste Operation in MS Word 

Microsoft Word or MS-Word is a powerful word processing program which have many 

features, and it allows you to create documents such as letters, articles, etc. It is very much 

user-friendly and interactive to the user, i.e. is easy to work with because of the vast features 

provided by the MS-Word. 

Copy and Paste Operation 

As of the many features provided by the MS-Word, Copy and Paste Operation is 

majorly used one. This operation is used when the user has the content previously written or 

has already written content somewhere else (in any other document or in memory somewhere) 

then copy content from there and paste it where required in the MS-Word document (which is 

currently in progress). With the help of this operation, users can save there valuable time.  

So, to learn this easy and very effective operation, we will learn with the help of images 

and instruction and learn this Copy and Paste operation in MS-Word. 

Method 1: Steps to follow for copy and Paste operation: 

Step 1: First open MS-Word in your PC. 

Step 2: Now, Open the document or create new one in which you want to do the copy and 

paste operation. 

 

Step 3: Now, go to the "Home tab" (shown in the picture) 



 

Step 4: Now, select a text or word or paragraph or any part of content which you want 

to Copy.  

Step 5: Now, go to the "Clipboard" section in home tab (marked by circle in the image 

below). 

 

Step 6: Now as you have already selected the text to be copied, then in "Clipboard" there is a 

option called "Copy"(marked in the image below). Select the "Copy" option to copy the text 

successfully. 

 

Step 7: Now, Select or Choose a place where you want to paste the text you have copied. Place 

the cursor there. (For example, here we want to place the Cursor after "Hi Geeks!") 

Step 8: Now, again go to "Clipboard" section and click on the option "Paste"(marked in the 

image below) to successfully paste the text you have copied earlier. 



 

Step 9: You have successfully pasted the copied text. 

 

This way we can easily complete the copy and paste operation. 

Method 2: Shortcut Keys 

Also, there is another way, or we can say the shortcut way. So, for that we have to 

know about the shortcut keys which are: 

Shortcut Key for Copy = "Ctrl + C" 

Shortcut Key for Paste = "Ctrl + V" 

Now, We will again see Step by Step Copy and Paste operation with the help of images and 

instructions we will learn and also with the help of shortcut keys.  

Steps to follow for copy and Paste operation with the help of Shortcut keys:  

Step 1: First open MS-Word on your PC. 

Step 2: Now, Open the document or create new one in which you want to do the copy and 

paste operation. 



Step 3: Now, select a text or word or paragraph or any part of the content which you want to 

Copy.  

Step 4: Now, to copy the selected text, Press "Ctrl + C". The text copied successfully.  

Step 5: Now, Select or choose a place where you want to paste the text you have copied. Place 

the cursor there. (For example, here we want to place the Cursor after "Hi Geeks!") 

Step 6: Now, to paste Press "Ctrl + V". The copied text is pasted at selected place 

successfully. 

     

 

 

 

 

 

 

 

         

 

 

 

 

 

 

S. No Question (5 Mark) LOCF Mapping 

1. Explain the steps to create a new document. CO2 PO1 K2 

2. Discuss the process of opening and closing a 

document. 

CO2 PO1 K2 

3. Analyze the importance of saving files. CO4 PO1 K4 

4. Explain the process of deleting files. CO2 PO1 K2 

5. Discuss the differences between cut, copy, and paste. CO4 PO1 K4 

 

 

Course Outcomes 

CO1: Explain the process of creating and managing documents. 

CO2: Demonstrate how to open and close files. 

CO3: Apply file operations such as save and delete. 

CO4: Analyze editing tools like cut, copy, and paste. 

CO5: Develop practical skills in document handling. 

Programme Outcome 

PO: To develop students’ basic computer application skills, 

enabling effective handling of documents and digital 

information. 



S. No Question (8 Mark) LOCF Mapping 

1. Explain file management in computers. CO2 PO1 K2 

2. Analyze the importance of document handling in daily 

work. 

CO4 PO1 K4 

3. Discuss the uses of editing tools in document creation. CO2 PO1 K2 

4. Explain the steps involved in saving and retrieving 

files. 

CO2 PO1 K2 

5. Evaluate the importance of basic computer skills in 

academics. 

CO5 PO1 K5 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



UNIT III 

 

Typing a letter and Curriculum Vitae 

 

 

 

 

 

 

 

 

 

How to Write A CV 

How to Write A CV: Seeking jobs in modern work is a challenging task. The 

evolution of technology has contributed to making lives easy and hard at the same time. For 

example, there are multiple tools and literature on how to write a Curriculum Vitae (CV) at the 

same time making the process of writing the best one that gets shortlisted hard. CV is often 

seen as an instrument of matchmaking between the employee and employer. 

So in this article, we will understand what is curriculum vitae is and its importance, 

how to write a curriculum vitae, how different it is from a resume, sections or essential 

information to be present, and finally, some hacks to make an ATS-friendly CV. 

What Is Curriculum Vitae and its importance? 

Curriculum vitae also known as a CV, is a comprehensive statement of the educational 

background, teaching, research experience, professional experience, skill sets and 

accomplishments of an individual. It's a comprehensive note of an individual's academic and 

professional journey. 

Curriculum Vitae (CV) is an important document that helps us unlock the door to an 

interview. This document makes the first impression of a job seeker to his recruiters, human 

resource managers, or hiring managers. 

What is the difference between a Curriculum Vitae and a Resume? 

Learning Objectives 

 To understand the format and structure of formal and informal letters.  

 To learn the steps involved in typing a letter using a computer.  

 To study the meaning and importance of a Curriculum Vitae (CV).  

 To examine the structure and components of a CV.  

 To develop skills in professional document preparation. 



In simple words, a Curriculum Vitae (CV) is a detailed version of a Resume. A Resume 

is a summary of your career, generally limited to a page or two. It is usually customized to the 

job that you are applying to by the job description (JD) provided. A CV is a detailed 

documentation that is multiple pages comprised of your educational background, job history 

and achievements, publications, awards, and any other key skill sets that are important to your 

industry. 

How should I write a Curriculum Vitae (CV) and what should be its appropriate length? 

There are no hard and set rules to be followed to write a Curriculum Vita. However, 

there are certain standard practices like adding and organizing all necessary sections of 

information, which will be discussed in upcoming sections of this article. Curriculum vitae 

should ideally be of 2-3 days and a maximum of 4 pages. It should cover all the necessary 

details, presented in an organized manner. Resume on the other hand can be a one-pager 

document, which included necessary portions from CV to meet the job descriptions on need-to-

have basis. 

What should I include in my CV? 

Writing a crisp brief introduction 

A brief introduction gives an overview of an individual's full name, professional title, 

phone number, home address, email address, and links to your social media profile as a part of 

the header. A particular add-on in this section is to have links to your portfolio which might 

give an adding edge among competitors. 

Employment history with description 

This section is important as a job seeker you will be pitching your experience and skills 

to the recruiter. You can list down all the places you have worked or interned with joining and 

leaving dates. It's essential to list the work you have done daily, quantify it, note achievements, 

crucial projects and responsibilities you have taken on. 

Academic history with description 

In this section mention all academic activities you have undertaken. It's an add-on to 

mention grades, subjects you have majored in so that the hiring managers can have a glance at 

the foundation knowledge you possess and understand your candidature. 

List down skills and achievements 



This is the crucial segment that reflects your skills and job readiness. You may add all 

necessary soft skills, tech skills you have been trained and equipped with. An add-on is to align 

your skills to those mentioned in the job description so that the recruiter will take cognizance 

in prioritization. List down all achievements, certificates and put a link to them as well so that 

your CV stands out in the crowd. 

Add any additional details 

You are always free to add any additional details that you want the recruiter to know about 

you. This way people can convey your interests, personal details which you seem significant. 

Additional relevant details might draw the interest of the recruiter. 

Types Of CV Formats 

There are various types of CV formats prepared for different purposes and career 

stages: 

 Chronological CV: In this CV format lists work experience, educational information is 

presented in the reverse chronological order, showcasing career progression. This is 

Ideal for those who have a continuous working experience without any gaps or breaks.  

Functional CV: This CV focuses on skills and achievements rather than work history. 

This is often suitable for career changers or those with diverse skills who are applying 

for roles which are different form what they have studies or pratcied earlier.  

 Combination CV (or Hybrid CV): As the name suggests its a combination of 

chronological and functional CV formats. It highlights both work experience and skills.  

 Resume or Targeted/Mini CV : It is a concise version of CV which is limited to one or 

two pages. It highlights key skills and experiences relevant to the job. It's customized 

for specific jobs or industries, emphasizing relevant skills and experiences. 

 Creative CV: This is a way of showcasing personality and creativity through unique 

design elements, suitable for creative industries. Usally followed by people in Graphics, 

Design roles. 

How do I navigate gaps in my CV? 

As the saying goes "Honesty is the best Policy", covering gaps in career or CV has to 

be done in a honest way with some subtlety. Carrer-gap is a common phenomena of the new 

age world. Being vocal and truth about it with employer or recruiting manger will set good 

precedence. 



 Provide an brief explanation to explain the reason for the gap. It maybe due to personal 

reasons, pursuing further education, taking care of family members, or exploring new 

opportunities, provide a clear and concise explanation. 

 Highlight Relevant Activities and skills gained in any volunteer work, freelance 

projects, part-time roles, or professional development activities during the gap period, 

include them in your CV. This emphasizes on the skills and experiences gained during 

the gap period that are relevant to the position you're applying for. 

What are Applicant Tracking Systems and ATS-friendly Curriculum Vitae? 

As a result of the digitalization phenomenon, new-age job recruitment has turned 

completely digital from drafting CVs on computer, using AI to make resumes, seeking jobs, 

submitting CVs by email and job portals, recruitment interview process on Zoom calls or 

online meeting each phase of candidate recruitment has seen digital intervention. 

On this line, many big companies and job portals have automated the process of 

shortlisting candidates using technology. Many software are built to shortlist suitable 

candidates based on their job and skill requirements and candidates' CVs. This software is 

called an applicant tracking system (ATS). 

 Tips for ATS complaint CV 

 Keep the CV Clean and use a standard professional font style while preparing a CV. 

 Preferably send out CVs or resumes in a PDF format so that it's easily readable. 

 While applying for the job include relevant skills as keywords and use titles as asked in 

the Job description. 

 Make CVs easy to read, and arrange information using bullet points and short sentences 

to list details. 

 Use a professional email address and keep things professional. 

 Proofread and correct grammar before sending out resumes or CVs. 

CV Template 

[Your Name] 

[Your Address] 

[City, State, Zip Code] 

[Your Email Address] 

[Your Phone Number] 



Objective: 

[Optional: Brief statement about your career goals or the position you are seeking] 

Work Experience: 

[Job Title] 

[Company Name], [Location] 

Dates of Employment (Month, Year - Month, Year) 

[Job Title] 

[Company Name], [Location] 

Dates of Employment (Month, Year - Month, Year) 

Description of responsibilities and achievements 

[Continue adding work experience as needed] 

Education: 

[Degree Earned], [Major/Field of Study] 

[Institution Name], [Location] 

Year Graduated] 

Skills: 

[Skill 1] 

[Skill 2] 

[Skill 3] 

Awards and Honors: 

[Award/Honor Name], [Issuing Organization], [Year Received] 

Certifications (if applicable): 

[Certification Name], [Issuing Organization], [Date Earned] 

Volunteer Experience (if applicable): 

[Organization Name], [Role/Position], [Dates of Involvement] 

Publications (if applicable): 

[Publication Title], [Journal/Conference Name], [Year Published] 

References: 

[Available upon request] 

CV Sample 

Mahesh R  



Bengaluru 

India 

[mailmrb@gmail.com 

+91 00000 00000 

Objective: 

Dynamic and results-driven Computer Science Engineer with a passion for research in 

computer networks. Seeking opportunities to leverage expertise in coding and networking to 

contribute to innovative projects and solutions. 

Work Experience: 

Software Engineer Intern 

Juniper Network, New York 

Jan 2018 – Present 

- Developed and maintained software applications for networking routers. 

- Collaborated with cross-functional teams to implement new features and enhancements. 

- Gained hands-on experience with computer netwokring softwares. 

Education: 

Master of Science in Computer Science Engineering – 2016 

Banglore University, Bengaluru 

9.2 CGPA 

Bachelor of Technology in Computer Science Engineering – 2014 

VTU, Dharwad 

8.6 CGPA 

Skills: 

- Proficient in programming languages including Java, Python, C++ 

- Strong understanding of computer networks concepts and protocols (TCP/IP, DNS,  

HCP, etc.) 

- Experience with network simulation tools such as NS-3 and Wireshark 

- Knowledge of software-defined networking (SDN) principles 

- Excellent problem-solving and analytical abilities 

Research Experience: 

Conducted in-depth research on computer networks. 



Published research paper titled "Privacy Protection in Networking" in IEEE Xplore. 

Presented findings at IEEE Conference, Tokyo. 

Research Assistant 

Banglore University, Bengaluru 

Jan 2015 - June 2016 

- Assisted in conducting experiments and data analysis for research projects in computer 

networks. 

- Contributed to the writing and editing of research papers and technical reports. 

Publications 

Mahesh, et al. "Privacy Protection in Networking." IEEE Explore, 2017. 

Awards 

Best young researcher award – 2016 

References: 

Prof. ABC 

mailabc@gmail.com 

 

      

 

 

 

 

 

 

           

 

 

 

 

 

 

 

Course Outcomes 

CO1: Explain the format and types of letters. 

CO2: Demonstrate the process of typing a formal letter. 

CO3: Describe the concept and purpose of a Curriculum Vitae (CV). 

CO4: Analyze the structure and components of a CV. 

CO5: Develop practical skills in preparing professional documents. 

Programme Outcome 

PO: To develop students’ professional communication and 

documentation skills, enabling effective preparation of letters 

and resumes for academic and career purposes. 



S. No Question (5 Mark) LOCF Mapping 

1. Explain the format of a formal letter. CO2 PO1 K2 

2. Discuss the steps involved in typing a letter. CO2 PO1 K2 

3. Analyze the importance of letter writing in 

communication. 

CO4 PO1 K4 

4. Explain the meaning and purpose of a Curriculum 

Vitae 

CO2 PO1 K2 

5. Discuss the structure and components of a CV. CO2 PO1 K2 

 

S. No Question (8 Mark) LOCF Mapping 

1. Explain the format of a formal letter. CO2 PO1 K2 

2. Discuss the steps involved in typing a letter. CO2 PO1 K2 

3. Analyze the importance of letter writing in 

communication. 

CO4 PO1 K4 

4. Explain the meaning and purpose of a Curriculum 

Vitae 

CO2 PO1 K2 

5. Discuss the structure and components of a CV. CO2 PO1 K2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



UNIT IV 

Power Point Presentation – Slide Creation – Inserting Pictures, Tables, Videos 

 

 

 

 

 

 

 

 

 

How to Create a PowerPoint Presentation 

How to Make a PowerPoint Presentation: Quick Steps 

Open PowerPoint >> Choose a Slide Layout 

Add Slide to Your Presentation  

Insert Text, Images, and Media 

Add Transitions >> Preview Presentation 

Save and Share Your Presentation 

Creating a PowerPoint presentation is an essential skill for students, professionals, and 

businesses. Whether you're preparing a classroom project, business proposal, marketing pitch, or 

webinar, PowerPoint offers a user-friendly interface and powerful design tools to create 

engaging and visually appealing slides. 

In this step-by-step guide, you’ll learn how to create a PowerPoint presentation, from 

choosing a template and adding content to designing slides and delivering your presentation 

effectively. 

Learning Objectives 

 To understand the basics of presentation software such as Microsoft PowerPoint.  

 To learn how to create and design slides effectively.  

 To study the process of inserting pictures, tables, and videos into slides.  

 To analyze the importance of visual communication in presentations.  

 To develop skills in creating professional and attractive presentations.  

 



  

 

What is Microsoft Power Point 

Microsoft PowerPoint is a presentation software developed by Microsoft as part of the 

Microsoft 365 suite. It allows users to create slideshow presentations with text, images, charts, 

animations, and multimedia elements. PowerPoint is widely used in business meetings, academic 

lectures, training sessions, and marketing presentations due to its flexibility and ease of use. 

How to Create a PowerPoint Presentation 

Creating a PowerPoint presentation is an essential skill for professionals, students, and 

businesses. Whether you need to make a business presentation, design a project report, or create 

a marketing pitch, Microsoft PowerPoint offers user-friendly tools to help you build engaging 

and professional slides. Follow the below steps to Create a Power Point Presentation. 

Step 1: Open Microsoft PowerPoint 

To start creating a presentation, open Microsoft PowerPoint on your computer. If you don’t have 

PowerPoint installed, you can use PowerPoint Online via Microsoft 365. 

How to Open PowerPoint 

 Click on the Start Menu and search for PowerPoint. 

 Click on the PowerPoint icon to open the program. 

 Select Blank Presentation to start from scratch or choose a pre-designed template. 



 

Pro Tip: Using Microsoft 365 PowerPoint allows you to access cloud storage (OneDrive) and 

collaborate in real-time with others. 

Step 2: Choose a PowerPoint Template 

PowerPoint provides a variety of built-in templates to help you create professional-looking 

presentations quickly. 

How to Choose a Template: 

 Open PowerPoint and select New Presentation. 

 Click on Design in the ribbon and choose from the available templates. 

 If you need more options, go to File > New and browse the template gallery. 

 Select a template and click Create to apply it to your slides. 

 



Pro Tip: Choose a template that matches your topic, audience, and branding to make your 

presentation more effective. 

Step 3: Create and Organize Your Slides 

A PowerPoint presentation consists of multiple slides, each containing different types of content. 

How to Add New Slides 

 Click the Home tab and select New Slide or Press "Ctrl + M" 

 Choose from different slide layouts like Title Slide, Content Slide, or Image Slide. 

 Click on the Slide Sorter View to rearrange slides for better flow. 

 

Pro Tip: Use a consistent slide layout and structure to keep your presentation organized and 

professional. 

Step 4: Add Text to Your Slides 

Adding clear and concise text helps convey your message effectively. 

How to Add Text in PowerPoint 

 Click inside a text box on a slide. 

 Type your content and use bullet points for better readability. 

 Use the Font options in the Home tab to change font style, size, and color. 

 Keep text short and engaging—avoid long paragraphs. 



 

Pro Tip: Use a professional font like Calibri, Arial, or Times New Roman to enhance readability. 

Step 5: Insert Images, Charts, and Graphics 

Visuals make presentations more engaging and help communicate ideas more effectively. 

How to Add Images in PowerPoint: 

 Click on the Insert tab. 

 Select Pictures to insert an image from your computer. 

 Choose Online Pictures to search for royalty-free images. 

 

How to Add Charts and Graphs: 

 Click on the Insert tab and select Chart. 



 Choose a chart type like Bar, Line, or Pie Chart. 

 Enter your data and customize the chart style. 

 

Pro Tip: Use high-quality images and well-designed charts to improve engagement. 

Step 6: Apply Transitions and Animations 

Transitions and animations add movement and make your slides more dynamic. 

How to Add Slide Transitions: 

 Click on the Transitions tab. 

 Choose a transition effect like Fade, Push, or Wipe. 

 Adjust the speed and duration for smooth transitions. 



 

How to Add Animations to Objects: 

 Click on the Animations tab. 

 Select an object (text, image, or chart). 

 Choose an animation effect like Appear, Fly In, or Zoom. 



 

Pro Tip: Use animations sparingly to avoid distractions. 

Step 7: Add Speaker Notes for Your Presentation 

Speaker notes help you remember key points while presenting. 

How to Add Speaker Notes: 

 Click on the Notes section below the slide. 

 Type important reminders or talking points. 

 Use Presenter View during the presentation to see notes privately. 

 

Pro Tip: Keep notes short and to the point for easy reference. 



Step 8: Review and Proofread Your Slides 

Before presenting, review your slides for spelling errors, formatting issues, and consistency. 

How to Check for Errors: 

 Click on Review > Spelling & Grammar to check for typos. 

 Use Slide Sorter View to check the order and flow. 

 Ensure consistent fonts, colors, and alignments. 

 

Pro Tip: Ask a colleague to review your slides for clarity and readability. 

Step 9: Save and Share Your Presentation 

After completing your presentation, you need to save and share your presentation 

How to Save Your PowerPoint File 

 Click File > Save As. 

 Choose PowerPoint Presentation (.pptx) for future editing. 

 Select PDF if you want a non-editable version. 

 Save to OneDrive for cloud access and sharing. 



 

How to Share a PowerPoint Presentation 

 Send via email as an attachment. 

 Share through Microsoft Teams or OneDrive. 

 Export as a video for recorded presentations. 

 



Pro Tip: If presenting online, use PowerPoint Live in Microsoft Teams for interactive 

engagement. 

Step 10: Present Your PowerPoint Like a Pro 

When presenting, maintain eye contact, speak clearly, and engage your audience. 

How to Start a Slideshow 

 Click on Slide Show > From Beginning. 

 Use the Presenter View for private notes. 

 Navigate using arrow keys or clicker. 

 

Pro Tip: Practice beforehand and time your presentation for a smooth delivery. 

Conclusion 

Creating a PowerPoint presentation is a skill that enhances communication and 

engagement. Whether you're designing a business report, academic project, or marketing pitch, 

using professional templates, structured content, and engaging visuals makes a significant 

difference. 

By mastering slide creation, animations, speaker notes, and presentation techniques, you 

can deliver impactful and memorable presentations. Start exploring PowerPoint today and 

elevate your presentation skills! 

 

 



Inserting Pictures 

How to Insert a Picture in MS PowerPoint 

How to Add a Picture in PowerPoint: Quick Steps 

 Open MS PowerPoint >> Go to the Slide  

 Click on Insert Tab >> Select Pictures 

 Choose the Image >> Click Insert  

 Resize and Position >> Preview Results 

Ever wondered how to insert pictures in PowerPoint without distorting 

them? Adding images to Microsoft PowerPoint is one of the easiest ways to make your 

presentations more engaging, professional, and visually appealing. Whether you're creating 

a business pitch, educational lecture, or marketing presentation, inserting high-quality 

images can enhance storytelling, grab attention, and improve audience retention. 

But how do you add pictures in PowerPoint without losing quality? How can 

you format, resize, and position images correctly to make your slides stand out? In this 

guide, you'll learn step-by-step methods to insert images in PowerPoint, customize them for 

a professional look, and fix common issues related to image formatting. 

 How to Add a Picture in PowerPoint: Different Methods 

PowerPoint offers multiple ways to insert images based on your needs, design preferences, and 

formatting requirements. Below are some of the best methods to add pictures in PowerPoint 

while keeping them high quality and well-positioned. 

Method 1: Insert a Picture from Your Computer (Quick & Easy) 

This method is best for adding images saved on your device. It ensures high-quality 

image resolution and gives you full control over editing, resizing, and positioning. 

Step 1: Open Your Presentation 

Launch PowerPoint and open the slide where you want to insert the image. 

Step 2: Go to the "Insert Tab" 

Click on the "Insert" tab in the ribbon at the top. 



 

Step 3: Click on "Pictures" 

In the "Images" group, select "Pictures" and then click "This Device" to browse your 

computer files. 

 

Step 4: Select the Image File and Click "Insert" 

Locate and select the image you want to insert, then click "Insert". 



 

Step 5: Adjust and Resize 

Move and resize the image by dragging the corners to fit it perfectly into your slide. 

 

Method 2: Insert an Online Picture (Best for Free Stock Images) 

If you don't have an image on your device, PowerPoint allows you to insert royalty-free 

images directly from the internet. This method is useful for finding high-quality stock images 

without leaving PowerPoint. 

Step 1: Open the Insert Tab 

Go to the "Insert" tab in the top menu. 



 

Step 2: Click "Pictures" > "Online Pictures" 

Select "Online Pictures" to access Microsoft Bing’s image search 

 

Step 3: Search for an Image 

Type a keyword related to the image you need (e.g., "Business meeting", "Technology 

background"). 



 

Step 4: Choose an Image and Insert 

Select an image and click "Insert" to add it to your slide. 

 

Step 5: Resize and Position 

Adjust the image as needed to fit your presentation layout. 



 

Method 3: Copy and Paste an Image (Fastest Way to Add Images) 

If you have an image copied from a website, document, or another slide, you can quickly paste it 

into PowerPoint. This method is useful for quick edits and fast slide creation. 

Step 1: Copy an Image 

Right-click on an image from a website, another slide, or a document, and select "Copy" 

(or press Ctrl + C on Windows, Cmd + C on Mac). 



 

 

 Step 2: Open PowerPoint and Select the Slide 

Go to the slide where you want to insert the image. 

Step 3: Paste the Image 

Right-click on the slide and select "Paste" or press Ctrl + V (Windows) / Cmd + V (Mac). 

 

 

 



Step 4: Resize and Format 

Resize the image and adjust its brightness, contrast, or transparency under the Picture 

Format tab. 

 

Method 4: Insert a Screenshot (Best for Tutorials & Guides) 

If you need to capture and insert a screenshot into PowerPoint, this method allows you to 

take instant screen captures without needing additional software. 

Step 1: Open PowerPoint and Go to the Insert Tab 

Click on the "Insert" tab in the ribbon. 

Step 2: Select "Screenshot" 

In the "Images" group, click "Screenshot" and choose "Screen Clipping". 



 

Step 3: Select the Area to Capture 

Drag your cursor over the part of the screen you want to capture. 

Step 4: Insert and Adjust 

The screenshot will be automatically added to your slide. Resize and position it as 

needed. 

 

Common Issues & Fixes When Adding Pictures in PowerPoint 

Image Looks Blurry or Pixelated 

 Use high-resolution images (avoid low-quality web images). 

 Resize images proportionally to maintain quality. 



Image is Not Fitting Properly in the Slide 

 Use the Crop tool to trim unnecessary areas. 

 Resize images manually while holding the Shift key to maintain aspect ratio. 

Image is Covering Text or Other Elements 

 Use Send to Back (Right-click > Send to Back) to move images behind text. 

 Reduce transparency under "Picture Format" if needed. 

Conclusion 

Adding pictures to PowerPoint presentations is a simple yet powerful way to enhance 

your slides, improve visual appeal, and engage your audience. Whether you insert an image from 

your computer, use online pictures, take screenshots, or crop images into shapes, PowerPoint 

provides multiple options to fit your needs. 

By using the methods outlined in this guide, you can ensure high-quality, well-placed 

images that make your slides visually stunning. So, start adding images to PowerPoint today and 

make your presentations more dynamic and effective! 

 How to Insert Video in PowerPoint: 

 How to Add a Video in PowerPoint: Quick Steps 

 Open PowerPoint and Select the Slide  

 Click on Insert Tab >> Video >> Choose the Video 

 Click Insert >> Resize and Move the Video 

 Adjust Playback Settings >> Save and Preview 

Have you ever wondered how to insert a video in PowerPoint to make your 

presentation more interactive and engaging? Adding Videos can transform dull slides into 

dynamic and impactful presentations, making complex topics easier to understand and keeping 

your audience interested. Whether you’re embedding a YouTube video, inserting a local file, 

or linking an online video, PowerPoint offers multiple ways to integrate videos seamlessly into 

your slides. 

In this guide, you’ll learn how to add a video to PowerPoint, customize playback 

settings, and troubleshoot common issues. Whether you're creating a business presentation, an 

educational lecture, or a marketing pitch, mastering video integration will take your slides to 

the next level! 

 



How to Insert a Video in PowerPoint: Different Methods 

Adding videos in PowerPoint enhances visual appeal, engagement, and retention. 

Depending on your needs, you can insert videos directly from your device, embed online 

videos, or link videos for optimized file size. Below are the best methods to insert a video into 

PowerPoint: 

Method 1: Insert a Video from Your Computer (Best for Offline Playback) 

If you need a high-quality video without relying on the internet, inserting a video from 

your computer is the best option. This method ensures smooth playback without buffering and 

maintains the original video quality. 

Step 1: Open Your Presentation 

Launch PowerPoint and navigate to the slide where you want to add the video. 

Step 2: Go to the Insert Tab >> Click on Video 

Click on the "Insert" tab in the top menu. Under the "Media" group, select "Video" > 

"Video on My PC." 

 

 

 Step 4: Select Your Video File 

Browse your computer, choose the video file, and click "Insert." 



 

Step 5: Adjust Video Placement 

Resize and reposition the video to fit your slide layout. 

 

Step 6: Customize Playback Settings 

Click on the "Playback" tab to adjust settings like "Play Automatically," "Loop Until 

Stopped," or "Start on Click" 



 

 

  

Method 2: Embed a YouTube Video in PowerPoint (Best for Online Presentations) 

If you want to save storage space and access high-quality online content, embedding a 

YouTube video in PowerPoint is the perfect solution. This method allows you to integrate 

trending videos, tutorials, or promotional clips directly into your slides. 

Step 1: Open PowerPoint and Go to Your Slide 

Open the presentation and go to the slide where you want to embed the video. 

Step 2: Go to Insert Tab, Click on Video and Select Online Video 

Go to "Insert" > "Video" > "Online Video." 



 

Step 3: Paste the YouTube Video URL and Click on Insert 

Find the YouTube video, copy its link, and paste it into the "Insert Video" field. Press 

"Insert" to embed the video onto your PowerPoint slide. 

 

 

 Step 4: Resize and Position 

Adjust the size and position of the video player to fit your slide layout. 



 

Step 5: Ensure Internet Connectivity 

Remember, YouTube videos in PowerPoint require an active internet connection to 

play. 

Method 3: Link to an External Video (Best for Reducing File Size) 

If your video file is too large, linking it instead of embedding it will keep your 

PowerPoint file lightweight and prevent lag during presentations.  

Step 1: Go to the Insert Tab 

Open PowerPoint and click "Insert" > "Video" > "Video on My PC." 

Step 2: Select Your Video File 

Find your video file but instead of clicking "Insert," click the dropdown next to it and 

select "Link to File." 

 



 Step 3: Adjust Video Settings 

Resize and format your video as needed, just like embedded videos. 

 

Step 4: Ensure the Video File Stays in the Same Location 

Since PowerPoint only links to the video, moving the file might break the link. 

How to Customize Video Playback in PowerPoint 

After inserting a video, you can customize its playback settings to match your 

presentation style and ensure smooth transitions. 

1. Set Video to Play Automatically or On Click 

 Select the video and go to the "Playback" tab. 

 Choose "Start Automatically" or "Start On Click." 

2. Trim the Video for a Specific Clip 

 Click "Trim Video" under the "Playback" tab. 

 Adjust the start and end points to display only the relevant section. 

3. Loop or Mute the Video 

 Select "Loop Until Stopped" for continuous playback. 

 Choose "Mute" if you don’t want background audio. 

4. Add Fade-In and Fade-Out Effects 

 Click "Fade In" and "Fade Out" for a smoother video transition. 

Common Issues & Fixes When Adding Videos to PowerPoint 

1. PowerPoint Video Not Playing? 



Fix: Ensure you’re using a supported video format (MP4, WMV, AVI) and check video 

playback settings. 

2. YouTube Video Not Loading? 

Fix: Check your internet connection and ensure you’ve pasted the correct video URL. 

3. Video File Too Large? 

Fix: Compress the video by selecting "File" > "Compress Media." 

4. Linked Video Not Found? 

Fix: Keep the video file in the same folder as your PowerPoint presentation. 

Conclusion 

Incorporating videos into your PowerPoint presentation can elevate your content, 

increase engagement, and effectively convey complex ideas. Whether you’re embedding a 

YouTube video, linking an external video to reduce file size, or adding videos directly from 

your computer, PowerPoint offers seamless methods to integrate multimedia content into your 

slides. By customizing video playback settings, you can ensure smooth transitions and enhance 

the overall viewing experience for your audience. 

With the right video formatting and settings, your presentations will not only look more 

professional but will also captivate and inform your viewers. Whether you're delivering a 

business pitch, an educational lesson, or an entertaining webinar, mastering video integration 

in PowerPoint will take your presentation to the next level. 

 

 

 

 

 

 

 

 

 

 

 

 

Course Outcomes 

CO1: Explain the features of Microsoft PowerPoint. 

CO2: Demonstrate the process of creating slides. 

CO3: Apply techniques to insert pictures, tables, and videos. 

CO4: Analyze the role of multimedia in presentations. 

CO5: Develop effective presentation skills using digital tools. 

 



           

 

 

 

 

 

 

S. No Question (5 Mark) LOCF Mapping 

1. Explain the features of Microsoft PowerPoint. CO2 PO1 K2 

2. Discuss the steps involved in creating a slide 

presentation. 

CO2 PO1 K2 

3. Analyze the importance of slide design and layout. CO4 PO1 K4 

4. Explain how to insert pictures, tables, and videos in 

PowerPoint. 

CO2 PO1 K2 

5. Discuss the role of multimedia in enhancing 

presentations. 

CO4 PO1 K4 

 

S. No Question (5 Mark) LOCF Mapping 

1. Analyze the advantages of using PowerPoint in 

communication. 

CO4 PO1 K4 

2. Explain the steps to create an effective presentation. CO2 PO1 K2 

3. Discuss the importance of visual communication in 

presentations. 

CO4 PO1 K4 

4. Evaluate the role of digital tools in academic 

presentations. 

CO5 PO1 K5 

5. Analyze the impact of multimedia elements on 

audience engagement. 

CO4 PO1 K4 

 

 

 

 

 

 

Programme Outcome 

PO: To develop students’ digital communication and 

presentation skills, enabling them to effectively present ideas 

using multimedia tools. 



UNIT V 

Developing skills in Designing: Brochures – Newsletter – Videos – Websites 

 

 

 

 

 

 

 

 

 

How to Send Newsletters in Gmail 

Sending Newsletters through Gmail can be a game-changer for your email marketing 

strategy. Whether you’re a small business owner, a blogger, or just looking to keep your 

audience updated, Google newsletters offer a user-friendly and effective solution. In this 

article, you’ll learn the process of creating and sending an email newsletter using Gmail, with 

newsletter email examples. 

You’ll learn about the best practices for Gmail newsletter design, how to segment 

Gmail lists for newsletters, and how to make newsletter templates in Gmail. Discover the 

secrets to successful Gmail campaigns and make the most of Google’s powerful email tools to 

enhance your marketing efforts with Google newsletters. 

How to Send a Newsletter in Gmail 

Gmail isn’t typically used for large-scale email marketing, but for smaller operations, it can 

make a significant difference in how professional your emails appear. Here are a few ways to 

send newsletters in Gmail, 

Gmail’s Built-in Newsletter Templates 

Gmail now offers built-in email newsletter templates. Follow the step-by-step procedure given 

below for your reference, 

Step 1: Open Your Gmail and Compose a new Mail 

Open Gmail, Compose a new Mail, and click the “Choose layout” icon at the bottom of a new 

email.  

Learning Objectives 

 To understand the basic principles of design in communication media.  

 To learn how to create brochures and newsletters effectively.  

 To study the process of designing and editing videos.  

 To examine the fundamentals of website design and development.  

 To develop creative and technical skills in digital designing. 



 

Step 2: Choose a layout from the default layout option 

Gmail offers few default newsletter templates to send via email. Cick on the Edit button 

and create your own and desired template. 

 

Step 3: Customize your layout using the given options and Click on Insert Button given at 

the    bottom 

After choosing the layout, customize the layout by adding your logo, colors, fonts, and 

footer details. 



 

Step 4: See the results of Email Newsletter in Your Gmail 

Your Gmail Newsletter is inserted successfully, now edit as needed. 

 

12 Things to Consider for an Effective Brochure Design 



 

Designing a brochure that is worth keeping is a challenging feat. An effective brochure should 

not only convey information and be eye-catching but should also resonate and leave a lasting 

impression. So, how do you make a brochure that is worth keeping? In this article, we’ll explore 

the various 12 elements that you need to consider for effective brochure design.      

https://www.printrunner.com/brochure-printing.html


12 Things to Consider for an Effective Brochure Design 

 

1. Determine your purpose. 

Before getting into brochure design, the first step is identifying your 

brochure’s objectives. Are you targeting a specific demographic? Will it be distributed by hand 

or sent through direct mail? What results do you hope to achieve? Answering these questions can 

help determine the direction of your brochure marketing so that you can easily choose which 

design to go for.   



2. Know your brochure folds. 

Brochures are known for a lot of various folds, and these help you manage how your 

product and service information are presented. When choosing the right brochure 

fold, you’d want a style that complements your content, something that makes it easier for 

your recipients to read your material. For example, a list of product features or a step-by-step 

procedure may benefit more from a trifold or roll fold brochure as these are ideal 

in revealing sequences.  

 

PrintRunner currently offers nine types of brochure folds, each with its unique features and 

recommended applications. To learn more about them, check out our blog post on brochure 

folds. 

3. Review your copy. 

The content of a brochure is crucial, as is how you present or convey that information. Ensure 

that your copy is concise, understandable, and straightforward. Too much information can 

overwhelm your readers and could leave them uninterested. Check for spelling and grammar 

mistakes, and make sure your copy is attuned with the overall visual design.  

https://www.printrunner.com/blog/brochure-folds/
https://www.printrunner.com/blog/brochure-folds/


 

4. Choose your fonts. 

Fonts affect the readability of your text, set the tone of your brochure, and impact its 

overall visual appeal. Choose font combinations that match your brand identity, and ensure they 

are easy to read. Limit your font choices from two to a maximum of three and use these for the 

heading, subheading, and body text.   

5. Know your paper stock and coating. 

Familiarize yourself with the paper stock you’ll print your brochure on, as well as the 

coating that you can use to enhance it. Your choice of paper stock and coating can influence how 

customers perceive your company — brochures made with thicker paper stock and a glossy or 

matte coating will feel more sophisticated than those made with thinner variants.   

Your choice of paper stock and coating will also affect durability. Heavier stock usually lasts 

longer than lighter ones, while coatings can protect your brochure from smudging and abrasions 

and make colors more vibrant.  

6. Use high-resolution photos. 

Image quality is crucial in effective brochure design. If you’re going with stock photos, 

use the ones that do not look generic and are appropriate for your brand. If you’re going to shoot 

product images, make sure that they are arranged in a visually appealing way, especially 

omnibus setups. Consider hiring a professional photographer to help you with art direction and in 

ensuring the quality of your product presentation. But if you plan to take the photos yourself, 

prepare by watching online tutorials on creating an ideal product photography setup, plan 

layouts, and rehearse techniques before the actual shoot. 

https://www.youtube.com/watch?v=eaPWuBBtd8A


 

7. Include a call-to-action. 

The call-to-action is the most important section of your brochure. This is where you 

lead customers to act, whether it’s to buy your products, visit your website, or 

avail your discounts, so you have to be specific about what it says. Make your call-to-

action immediately visible to your recipient by using a bigger font or larger white space around it 

to make it stand out. For better results, include an incentive for readers — things like coupons or 

exclusive promotions can encourage customers to act after reading your brochure.     

8. Create an eye-catching headline and cover design. 

Your brochure headline and cover design are the first things readers will see when they 

receive your brochure. Write a clear and eye-catching headline to go with an awesome cover 

design to draw attention and encourage people to read your brochure.   

9. Maintain a balanced layout. 

A balanced layout will not only look aesthetically pleasing, it will also make your content 

easier on the eyes. Give your readers a great visual treat by breaking down  large blocks of 

text, using high-quality images, and avoiding distracting graphics that can make the layout look 

cluttered.   

10. Pick your colors wisely. 

Colors can instantly influence your readers and evoke certain emotions. Choose a color 

palette that is consistent with your brand’s theme and mix and match different shades until you 

achieve a scheme that will attract people to pick up your brochure.   

 



 

11. Give your readers the option to engage. 

In line with having a good call to action, ensure that your business information, such as 

your name, website, email address, phone number, and social media accounts, are present in your 

brochure. This will help readers reach out to you should they have any inquiries about your 

business or the products and services you offer. 

12. Get creative. 

Don’t be afraid to test various designs and combinations. Go the unconventional route 

and get creative in laying out your brochure. You can experiment with unique shapes, add 

inserts, or play around with the type of fold to make your brochure stand out when placed in the 

rack. Creating an effective brochure design involves strategic planning, compelling content, and 

eye-catching visuals. With a well-designed brochure, you can elevate your brand and attract 

potential customers with ease. 

What Are Effective Presentation Skills (and How to Improve Them) 

Presentation skills are essential for a successful career in many fields. They are important 

for building confidence, enhancing collaboration, and developing robust critical-thinking skills. 

Although it might be tempting to think these skills are reserved for people interested in public 

speaking roles, they're critical in diverse jobs. For example, you may need to use presentation 

skills to pitch new ideas to clients or to explain your perspective on an issue to a manager.  

Presentation skills are essential in various scenarios, including working with a team and 

explaining your thought process, walking clients through project ideas and timelines, and 

highlighting your strengths and achievements to your manager during performance reviews. 

Whatever the scenario, you want to begin by capturing your audience’s attention with a well-

crafted opening and get your point across when presenting information. Effective presentation 

skills help you get your point across and connect with the people you’re communicating with, 

which is why nearly every employer requires them. Understanding what presentation skills are is 

only half the battle. Honing your techniques is essential for mastering presentations of all kinds 

and in all settings. 

What are presentation skills? 

Presentation skills are the abilities and qualities necessary for creating and delivering a 

compelling presentation that effectively communicates information and ideas. They encompass 



what you say, how you structure it, and the materials you include to support what you say, such as 

slides, videos, or images. 

You'll make presentations at various times in your life. Examples include: 

 Making speeches at a wedding, conference, or another event 

 Making a toast at a dinner or event 

 Explaining projects to a team  

 Delivering results and findings to management teams 

 Teaching people specific methods or information 

 Proposing a vote at community group meetings 

 Pitching a new idea or business to potential partners or investors 

Why are presentation skills important?  

Delivering effective presentations is critical in your professional and personal life. You’ll 

need to hone your presentation skills in various areas, such as when giving a speech, convincing 

your partner to make a substantial purchase, and talking to friends and family about an important 

situation. Whether you’re using them in a personal or professional setting, these skills make it 

easier and more effective to convey your ideas, convince or persuade others, and experience 

success. A few of the benefits that often accompany improving your presentation skills include: 

 Enriched written and verbal communication skills 

 Enhanced confidence and self-image 

 Boosted critical thinking and problem-solving capabilities 

 Better motivational techniques 

 Increased leadership skills 

 Expanded time management, negotiation, and creativity 

The better your presenting techniques, the more engaging your presentations will be. You 

could also have greater opportunities to impact business and other areas of your life positively. 

Effective presentation skills 

Imagine yourself in the audience at a TED Talk or sitting with your coworkers at a big 

meeting held by your employer. What would you be looking for in how they deliver their 

message? What would make you feel engaged? 

Those are a few questions to ask yourself as you review this list of effective presentation 

skills. 



Verbal communication 

How you use language and deliver messages is essential to how your audience will receive 

your presentation. Speak clearly and confidently, projecting your voice enough to ensure 

everyone can hear. Think before you speak, pausing when necessary, and tailoring the way you 

talk to resonate with your particular audience. 

Body language 

Body language combines critical elements, including posture, gestures, eye contact, 

expressions, and position in front of the audience. Body language is one of the elements that can 

instantly transform a presentation that would otherwise be dull into one that's dynamic and 

interesting. 

Voice projection 

Projecting your voice improves your presentation by allowing your audience to hear you. 

It also increases your confidence, helping to settle lingering nerves while making your message 

more engaging. To project your voice, stand comfortably with your shoulders back. Take deep 

breaths to power your voice and ensure you enunciate every syllable. 

Posture 

How you present yourself affects your body language and ability to project your voice. It 

also sets the tone for the presentation. Remain open, upright, and adaptable while considering the 

formality of the occasion instead of slouching or looking overly tense. 

Storytelling 

Many powerful public speakers use storytelling effectively and incorporate it into their 

presentations. Storytelling can bring your subject to life and pique the audience’s curiosity. Don’t 

be afraid to tell a personal story, slowly building up suspense or adding a dramatic moment. And, 

of course, be sure to end with a positive takeaway to drive your point home. 

Active listening 

Active listening is a valuable skill all on its own. When you understand and thoughtfully 

respond to what you hear—whether it's in a conversation or during a presentation—you’ll likely 

deepen your personal relationships and actively engage audiences during a presentation. As part 

of your presentation skill set, it helps catch and maintain the audience’s attention, helping them 

remain focused while minimising passive response, ensuring the message is delivered correctly, 

and encouraging a call to action. 



Stage presence 

During a presentation, projecting confidence can help keep your audience engaged. Stage 

presence can help you connect with your audience and encourage them to want to watch you. To 

improve your presence, try amplifying your normal demeanour with enthusiasm. Project 

confidence and keep your information interesting. Watch your audience as you present. If you 

hold their attention, it likely means you’re connecting well with them. 

Self-awareness 

Monitoring your emotions and reactions will allow you to react well in various situations. 

It will also help you remain personable throughout your presentation and handle feedback well. 

Self-awareness can help soothe nervousness during presentations, allowing you to perform more 

effectively. 

Writing skills 

Writing is a form of presentation. Sharp writing skills can help you master your 

presentation’s outline to ensure you stay on message and remain clear about your objectives from 

the beginning until the end. It’s also helpful to have strong writing abilities for creating 

compelling slides and other visual aids. 

Understanding an audience 

When you understand your audience's needs and interests, you can design your 

presentation around them. This will deliver maximum value to them and enhance your ability to 

make your message easy to understand. 

How to improve presentation skills 

Public speaking is an art form of sorts, and just like any other type of art, this is one that 

requires practice. Improving your presentation skills will help reduce miscommunications, 

enhance your time management capabilities, and boost your leadership skills. The following 

offers a few tips to help you improve these skills: 

Work on self-confidence. 

When you’re confident, you naturally speak more clearly and with more authority. 

Preparing your presentation with a strong opening and compelling visual aids can help you feel 

more confident. Other ways to improve your self-confidence include practising positive self-talk, 

surrounding yourself with positive people, and avoiding comparing yourself (or your 

presentation) to others. 



Develop strategies for overcoming fear. 

Many people are nervous or fearful before giving a presentation. A bad memory of past 

performance or insufficient self-confidence can contribute to fear and anxiety. Having a few go-to 

strategies like deep breathing, practising your presentation, and grounding can help you transform 

that fear into extra energy to put into your stage presence. 

Learn grounding techniques. 

Grounding is a technique that helps you steer your focus away from distressing thoughts 

and keeps you connected with your present self. To ground yourself, stand with your feet 

shoulder-width apart and imagine you’re a large, mature tree with roots extending deep into the 

earth—like the tree, you can become unshakable. 

Learn how to use presentation tools. 

Visual aids and other technical support can transform an otherwise good presentation into 

a wow-worthy one. A few popular presentation tools include: 

 Canva: Provides easy-to-design templates you can customise 

 Powtoon: Animation software that makes video creation fast and easy 

 PowerPoint: Microsoft's iconic program popular for dynamic marketing and sales 

presentations 

Practice breathing techniques. 

Breathing techniques can help quell anxiety, making it easier to shake off pre-presentation 

jitters and nerves. It also helps relax your muscles and get more oxygen to your brain.  For some 

pre-presentation calmness, you can take deep breaths, slowly inhaling through your nose and 

exhaling through your mouth. While presenting, breathe in through your mouth with the back of 

your tongue relaxed so your audience doesn't hear a gasping sound. Speak on your exhalation, 

maintaining a smooth voice. 

Gain experience. 

The more you practice, the better you’ll become. The more you do anything, the more 

comfortable you’ll feel engaging in that activity. Presentations are no different. Repeatedly 

practising your own presentation also offers the opportunity to get feedback from other people 

and tweak your style and content as needed. 



Tips to help you ace your presentation 

Your presentation isn’t about you but the material you’re presenting. Sometimes, 

reminding yourself of this ahead of taking centre stage can help take you out of your head and 

allow you to connect effectively with your audience. The following are many actions you can take 

on the day of your presentation. 

Arrive early. 

Since you may have a bit of presentation-related anxiety, it’s important to avoid adding 

travel stress. Give yourself ample time to arrive at your destination, and consider heavy traffic and 

other unforeseen events. By arriving early, you also give yourself time to meet with any on-site 

technicians, test your equipment, and connect with people ahead of the presentation. 

Become familiar with the layout of the room. 

Arriving early also allows you to assess the room and determine where you want to stand. 

Experiment with the acoustics to determine how loudly you need to project your voice and test 

your equipment to make sure everything connects and appears properly with the available setup. 

This is an excellent opportunity to work out any last-minute concerns and move around to 

familiarise yourself with the setting for improved stage presence. 

Listen to the presenters ahead of you. 

When you watch others present, you'll get a feel for the room's acoustics and lighting. You 

can also listen for any relevant data and revisit it during your presentation—this can make the 

presentation more interactive and engaging. 

Use note cards. 

Writing yourself a script could provide you with more comfort. To prevent sounding too 

robotic or disengaged, only include talking points in your note cards if you get off track. Using 

note cards can help keep your presentation organised while sounding more authentic to your 

audience. 

Improve your presentation skills with Coursera. 

Cultivating effective presentation skills can be helpful in your personal and professional 

life, aiding you in everything from making a toast at your next celebration to pitching your team 

on a new project. Rehearsing your presentation and preparing ahead of time can help smooth the 

way forward, but these are only two options to improve your presentation skills. Learn to deliver 

clear and confident presentations with Dynamic Public Speaking from the University of 

https://www.coursera.org/specializations/public-speaking


Washington. Build confidence, develop new delivery techniques, and practice strategies for 

crafting compelling presentations for different purposes, occasions, and audiences. 

Newsletter Design 

 A newsletter is an electronic document with information about and from your 

organization. To design a newsletter for your organization or company, you need to know what 

content to write about and the best way to engage your readers. Understanding how to structure 

and distribute your newsletter can help increase subscribers and drive traffic to your 

organization's website.  Email newsletters can be used to deliver information to people within 

your company network, such as your employees or stakeholders, or directly to your consumers or 

potential customers. In this article, we provide 20 useful tips you can use when designing a 

newsletter for your organization. 

Tips for designing a newsletter 

Once you’ve learned the basics of how to create a newsletter, you can pay attention to the 

newsletter design. You can follow these tips when designing your organization's newsletter: 

1. Find a distribution program 

Distribution programs have tools you can use to deliver your newsletter to your readers. 

You can schedule the exact delivery time and select who you want to receive your newsletter. 

You can also organize and access each edition of your newsletter in one system and manage your 

subscribers. Examples of newsletter distribution programs include: 

 Campaign Monitor 

 HubSpot 

 Mailchimp 

 Microsoft Publisher  

 Squarespace 

 Sender 

2. Select an email design software  

Email design software programs have tools that can allow you to design your newsletter 

and save your work. Look for software that permits you to attach images and manipulate colors 

and fonts. You may also consider the format you need for downloading your newsletter such as a 

.pdf, which can affect how your newsletter will appear. Examples of email design software 

include: 

https://www.indeed.com/career-advice/career-development/how-to-start-a-newsletter
https://www.campaignmonitor.com/
https://www.hubspot.com/products/marketing/newsletter-builder
https://mailchimp.com/
https://microsoft.com/en-us/microsoft-365/publisher
https://www.squarespace.com/
https://www.sender.net/
https://www.indeed.com/career-advice/career-development/what-is-pdf


 Adobe Creat ive Cloud Express  

 Canva 

 Lucidpress 

 Chamaileon 

 Postcards 

 Stripo 

 Visme 

3. Identify a target audience  

A target audience is the group of people who may most benefit from reading your 

newsletter. For example, your target readers might be a particular age group or those who live in 

the same geographical area where your organization is located. During the creation process, it's 

important to design the content of your newsletter based on the interests of your target audience. 

You can take into consideration: 

 Information your target audience would find most relevant  

 The type of language your target audience responds to 

 The plat forms your target audience frequents  

 Actions you want your target audience to take after reading your newsletter  

4. Create a theme 

The theme of your newsletter can dictate the newsletter's content and your calls to action. 

Consider the goal of your newsletter and what messages you want to send about your 

organization. For example, perhaps you want to use your newsletter to promote a concert and 

detail the headlining acts and ticket prices. You may also use your newsletter to discuss new 

happenings in your organization, such as employee promotions.  

Related: How To Create Email Subscriptions Worth Subscribing To 

5. Name the newsletter 

Naming your newsletter can complement its theme and coincide with your professional 

rand. You can create a name that may be easy for readers to recognize when they receive your 

newsletter. Your newsletter's name can also be homage to the name of your organization or its 

symbol. 

 

 

https://www.adobe.com/express/
https://www.canva.com/
https://www.lucidpress.com/pages/templates/newsletters/email
https://chamaileon.io/
https://designmodo.com/postcards/
https://stripo.email/
https://www.visme.co/newsletter-maker/
https://www.indeed.com/career-advice/career-development/how-to-find-target-audience
https://www.indeed.com/career-advice/career-development/email-subscription


6. Choose a format 

The format of your newsletter can determine how it will appear to readers. You can 

consider the devices readers may use to read your newsletter. For example, your target audience 

may primarily use mobile devices to access emails so you may need to design your newsletter for 

mobile users. You may also consider if you want your newsletter to look different on mobile 

devices and desktops. 

7. Structure a simple layout  

Elements of a newsletter layout can include: 

 Subject line: A newsletter subject line is the line of text that appears in an 

email inbox next to the sender's name.   

 Headings: Headings divide your newsletter cont ent into sect ions that readers 

can scan, and they show the major elements of your content. Consider using 

strategic keywords that can capture your readers' interest as they review your 

newsletter. 

 Subheadings: Subheadings appear between headings to show mo re specific 

components of a broader topic. For example, if the heading is "New 

Employees," your subheadings might be "The Market ing Team" or the 

"Human Resources Department."  

 Headers: Headers are visual components that appear at the top of your 

newsletter and serve as the first thing readers will see when they open the 

email. Headers often can include the name of your newsletter and 

organizat ion, as well as its logo. 

 Footers: Footers appear at the bottom of the newsletter and may frame the 

email. They may include links to your social media accounts and options for 

readers to sign up for more emails or unsubscribe.  

8. Type with standard fonts  

Standard fonts can improve the readability of your newsletter. It's important that your 

subscribers can interpret the text regardless if they're viewing your newsletter over their mobile 

devices or desktops. Creation and distribution tools may use standard fonts, which ensures your 

newsletter will transfer the way you want it to from one software to the next. Examples of 

standard fonts include: 

https://www.indeed.com/career-advice/career-development/newsletter-subject-lines
https://www.indeed.com/career-advice/career-development/what-is-marketing


 Arial 

 Times New Roman 

 Helvet ica 

 Sans Serif 

9. Make use of white space 

White space can help separate the sections of your text, make your newsletter easier to 

scan or interpret and can help emphasize your content. Consider adding white space to break up 

long blocks of text or can add extra space between headings and subheadings to distinguish them 

from one another. 

Related: 15 Effective Strategies To Increase Newsletter Sign-ups 

10. Attach images and videos 

Attaching images and videos can illustrate your content and make your newsletter more 

appealing. For example, if you're documenting an event that took place, you can include images 

and video links to show your readers how and what occurred. If you're discussing future 

organizational goals in your newsletter, such as the groundbreaking of a new building, you can 

include photos and videos of the construction process. 

11. Show some personality  

Using GIFs can add personality and authenticity to your newsletter. GIFs are animated 

images that express emotions or add comedy. For instance, if you write about the excitement in 

your organization for the next quarter, you can use a GIF from a well-known movie or television 

show that depicts excitement. 

12. Keep your information concise  

Having a concise newsletter can encourage readers to interact fully with the content of 

your newsletter. As you write the text, you can use direct, specific descriptions to communicate 

your information as concisely as possible. It may be helpful to link to external resources, such as 

your organization's website, for more information about topics instead of including extensive 

descriptions. 

Related: How To Write an Effective Newsletter 

13. Write a good headline 

Your headline is the first line of text your subscribers may read in your newsletter. Use 

language that can attract the interest of the readers and encourage them to continue reading your 

https://www.indeed.com/career-advice/career-development/newsletter-sign-up-strategies
https://www.indeed.com/career-advice/career-development/how-to-create-a-newsletter


newsletter. You can also communicate the purpose of the newsletter in your headline to offer 

insight into its content. 

14. Apply consistent branding 

Your newsletter can serve as a representation of your professional brand, which can help 

your readers easily identify your organization and what it means. Here are ways you can apply 

consistent branding to your newsletter: 

 Add your slogan: If you have words or phrases that help your organizat ion 

stand out, you can include them in your newsletter to help your readers 

ident ify your brand.  

 Include logos and symbols: Logos and organizat ional symbols also represent 

your organizat ion. You can paste your logo at the top of your newsletter so 

it 's the first thing readers may see.  

 Use signature colors: When deciding the colors for your newsletter, select the 

same color schemes you use on your website, business ca rds or office to 

encourage consistent branding. You can use the hex codes to ensure you're 

using the exact shades.  

Related: What Is Email Branding? (And How To Use It) 

15. Use thumbnails for other content  

Thumbnails are images that can direct readers to similar organizational content. For 

instance, in your newsletter, you can include thumbnails to blog articles or previous newsletter 

editions. You may have a video on your website that applies to the content of the newsletter, so 

you can include a thumbnail from the video on the newsletter. Thumbnails can attract the readers' 

attention as they scroll through the newsletter and help you boost activity on other online 

platforms of your organization. 

Related: How To Create a YouTube Thumbnail in 6 Steps (With Tips) 

16. Include a call to action  

Using a call to action could mean asking your subscribers to do something after reading 

your newsletter such as learning more about your organization. Here are examples of calls to 

action you can include in your newsletter: 

https://www.indeed.com/career-advice/career-development/slogans-for-a-company
https://www.indeed.com/career-advice/career-development/how-to-design-a-logo
https://www.indeed.com/career-advice/career-development/what-is-email-branding
https://www.indeed.com/career-advice/career-development/how-to-create-youtube-thumbnail
https://www.indeed.com/career-advice/career-development/call-to-action


 Visit ing the organizat ion's website:  If you discuss your organizat ion's 

services in the newsletter, you can direct subscribers to your website where 

they can learn about what you do and what you provide. 

 Following social media plat forms:  You can include the logo of the social 

media plat forms your organizat ion uses with active links that direct  

subscribers to those plat forms when they click on them.  

 Purchasing t ickets to events:  If you use your newsletter to promote upcoming 

events, you can include a link that directs readers to the site where they can 

purchase tickets or make reservat ions.  

 Submit quest ions: Your readers may have quest ions after reading your 

newsletter, so you can include a portal for them to send their quest ions 

direct ly to you. 

Related: Customer Satisfact ion: 70 Quest ions for Feedback  

17. Stick to a consistent schedule  

It's important that you distribute your newsletter consistently to keep your readers. Think 

about the content you want to promote and how often you need to promote it. For example, your 

organization may host several events for charity a month, so you may need to distribute a 

newsletter once a week to document past events and promote upcoming ones. Here are examples 

of newsletter delivery schedules: 

 Twice weekly 

 Weekly 

 Bi-weekly 

 Twice monthly 

 Monthly 

 Quarterly 

 Semi-annually 

Annually 

18. Proofread your newsletter 

It's important that your newsletter is free from grammatical and spelling errors. Before 

you schedule its distribution, carefully read over your text and preview the layout. You can also 

ask your colleagues to review the newsletter to catch any errors you may have overlooked. 

https://www.indeed.com/career-advice/interviewing/questions-for-feedback


Asking for feedback can also help you determine if the content of your newsletter is engaging 

and communicates details about your organization thoroughly. 

19. Perform a test run 

With a test run, you can make sure your newsletter meets your standards before you 

officially send it to readers. You can review its colors and format, checking that it's easy to read 

and appealing to the eye. You can click on your active links to ensure they go to the correct 

websites, and you can check the location of the newsletter's destination. For example, if you 

discover your distribution tool sends your newsletter to an email's spam folder, you can make 

adjustments so your readers can find your newsletter more easily. 

Related: 10 Newsletter Ideas to Engage Your Subscribers 

20. Review the analytics 

Tracking the analytics of your newsletter, like the average email open rate, can allow you 

to determine its success or if you need to make any changes. For example, if you find your 

current schedule is not frequent enough to engage readers, you may choose to distribute the 

newsletter once a week instead of once a month. To show how well your newsletter performed, 

you can also review the number of times readers clicked your active links, which may have 

directed them to your organization's website or your social media platforms. 

Video Design: Differences & Similarities 

Marketable design skills refers to the design skill sets of graphic designers and video 

designers. While many of these skills overlap between the two professions, they are still very 

much different from each other; however, those who have both graphic and video skills are 

bound to create limitless opportunities for themselves. The essential difference between graphic 

designers and video designers is the content in which they produce. Marketable design skills 

specific to each profession can be distinguished by the software knowledge needed in order to 

create graphic or video content. Those interested in graphic design need proficiency in software 

found in Adobe Creative Cloud such as Photoshop, Illustrator, and InDesign and those interested 

in video design need proficiency in Adobe software like Premiere Pro and After Effects. 

In regard to creative expression and visual communication, graphic and video designers 

have a great deal of similarities. Both professions need to have a “keen eye for detail, a strong 

understanding of color theory and typography, and the ability to use software tools to create 

stunning visual content,” as noted in a recent LinkedIn article. Since Adobe software is at the 

https://www.indeed.com/career-advice/career-development/newsletter-ideas
https://www.indeed.com/career-advice/career-development/email-metrics
https://www.indeed.com/career-advice/career-development/average-email-open-rate
https://www.adobe.com/creativecloud.html
https://www.linkedin.com/pulse/graphic-design-video-editing-comparison-career-options-rathor/


core of the skill sets for those in the graphic and video design professions, the similarities 

between these professions are also found in software knowledge and language as well. Those 

who know how to use all of Adobe Creative Cloud to create both graphic and video content have 

the chance to open a plethora of doors of opportunity as they blend the differences into one big 

skillset. 

Career Possibilities in Graphic & Video Design 

Those proficient in either or both graphic and design skills can market themselves into a 

wide range of career opportunities. Whether through freelancing, joining a marketing agency, or 

landing a designer job at a business or organization, those with marketable design skills can find 

that their skills and knowledge are in high demand across industries. Professionals with graphic 

design skills can find careers in just about any type of business under job titles like graphic 

designer, web designer, content specialist, and digital illustrator. There are many other jobs that 

those with graphic design skills can secure such as art directors, social media marketers, and 

content creators. Professionals with video editing and design skills can find employment under 

job titles such as video editors, video content strategists, special effects artists, and animator. 

Video editing and design professionals can also find opportunities in marketing and art 

management jobs. Those who are skilled in both graphic and video design can clearly see how 

many paths that could be possible. 

Here are some career outlook fast facts in regard to both professions: (data pulled from the U.S. 

Bureau of Labor Statistics) 

 Careers for Graphic Designers are increasing by 3% from 2022-2032, as fast at the national 

average. 

 Careers for Video Designer/Editors are increasing by 7% from 2022-2032, faster than 

average. 

 In 2022, there were 270,900 available Graphic Design jobs and 87,500 available Video 

Design Jobs 

 Median pay for Graphic Designers in 2022: $27.88 an hour 

 Median pay for Video Designers/Editors in 2022: $30.01 an hour 

Fostering Marketable Design Skills 

While similar in the fact that Adobe software is at the core of the skill and knowledge 

base for both graphic and video designers, essential skills differ for both professions. There are a 

https://www.bls.gov/
https://www.bls.gov/
https://www.bls.gov/ooh/arts-and-design/graphic-designers.htm
https://www.bls.gov/ooh/media-and-communication/film-and-video-editors-and-camera-operators.htm


number of skills that employers look for in graphic and/or video designers to complete needed 

tasks, so professionals must make sure they have the essential skills as foundation before 

marketing themselves as graphic and video designing professionals. O*NET OnLine, an 

extension of the U.S. Department of Labor, is a tool created for career exploration and job 

analysis, with “detailed descriptions of the world of work for use by job seekers, workforce 

development and HR professionals, students, developers, researchers, and more.” The following 

essential skills for each profession are pulled from the comprehensive reports that are on O*NET 

OnLine. 

Essentials Skills in Graphic Design 

Proficiency in Adobe software Photoshop, Illustrator, and InDesign set the foundation for 

fostering essential skills in graphic design. Some of the most important tasks related to the 

responsibilities of a graphic designing professional are as follows: 

1. Develop graphics and layouts for product illustrations, company logos, and websites. 

2. Create designs, concepts, and sample layouts based on knowledge of the principles of design. 

3. Use digital software to draw charts, graphs, illustrations, and other artwork. 

4. Generate and prepare digital images and files for print. 

5. Review final layouts and suggest improvements as needed. 

Essentials Skills in Video Design 

Proficiency in Adobe software Premiere Pro and After Effects set the foundation for 

fostering essential skills in video design and editing. Some of the most important tasks related to 

the responsibilities of a video designing and editing professional are as follows: 

1. Select and combine the most effective video clips to form a logical and smoothly running 

story. 

2. Manipulate plot, score, sound, and graphics to make parts into a continuous whole. 

3. Use software to edit and add music, dialogue, sound effects, and to correct errors. 

4. Trim clips to specific lengths and reassemble clips in sequences that present stories with 

maximum effect. 

5. Review assembled projects to determine if corrections are needed. 

 

 

https://www.onetonline.org/
https://www.onetonline.org/
https://www.onetonline.org/


Using Certificate Programs to Foster Marketable Design Skills 

DWC Certificate programs are designed to teach and help improve skills in a real-world 

setting. Our experiential learning style ensures guidance by an expert instructor in a hands-on 

format and the challenges faced in class mimic the challenges found on the job and will provide 

the solutions needed to land the job and improve productivity. Each certificate program comes 

with a real-world project to foster real-world tasks and responsibilities as well as one-on-one job 

search and resume writing assistance with a career coach. By taking one (or both) of the 

certificate programs geared towards graphic and video design, marketbale design skills can be 

fostered and improved upon. 

 Advanced Graphic Design Certificate Program 

The Advanced Graphic Design certificate program focuses on high demand graphic 

design skills and software such as Photoshop, Illustrator, and InDesign. In addition to graphic 

design courses, the certificate program includes design fundamentals and soft skills classes to 

teach the language of graphics and to highlight the difference that elevates today’s modern 

designs. Upon successful completion, students will be able to understand the principles of 

design, speak clearly on the concepts of design with other designers, edit images using Adobe 

Photoshop techniques, create logos and branding materials with Adobe Illustrator, design 

complex layouts using Adobe InDesign, and integrate Adobe programs using Adobe CC 

libraries. 

Video Design Certificate Program 

The Video Design certificate program offers necessary classes to provide a foundation in 

video software such as Adobe Premier Pro and After Effects. With additional classes in Adobe 

Photoshop and Illustrator, those enrolled in this certificate program will walk away with 

understanding the process of design for a video project as well as the knowledge to create 

something visually compelling. 

Upon successful completion, students will explore the principles and elements of design, 

use Adobe Photoshop to edit still images used in video assets, understand best practices and 

terminology for video production, create dynamic videos using Adobe Premiere Pro, design and 

implement animations using Adobe After Effects, understand video marketing concepts and 

storytelling, create content strategies for video marketing, and examine/analyze video metrics for 

social and digital channels such as YouTube. 

https://digitalworkshopcenter.com/classes/adobe-creative-cloud-classes/adobe-photoshop-classes/adobe-photoshop-advanced-level-2/
https://digitalworkshopcenter.com/classes/adobe-creative-cloud-classes/adobe-illustrator-classes/adobe-illustrator-advanced-level-2/
https://digitalworkshopcenter.com/classes/adobe-creative-cloud-classes/adobe-indesign-classes/adobe-indesign-advanced-level-2/
https://digitalworkshopcenter.com/classes/adobe-creative-cloud-classes/adobe-premiere-pro-classes/adobe-premiere-pro-beginners-level-1/
https://digitalworkshopcenter.com/classes/adobe-creative-cloud-classes/adobe-after-effects-classes/adobe-after-effects-beginners-level-1-2/
https://digitalworkshopcenter.com/classes/adobe-creative-cloud-classes/adobe-photoshop-classes/adobe-photoshop-advanced-level-2/
https://digitalworkshopcenter.com/classes/adobe-creative-cloud-classes/adobe-photoshop-classes/adobe-photoshop-advanced-level-2/
https://digitalworkshopcenter.com/classes/adobe-creative-cloud-classes/adobe-illustrator-classes/


Being a web designer involves harmoniously combining visuals and content. But non-

technical skills, like collaboration and communication, are also important. 

The demand for skilled web designers today continues to surge as businesses of all sizes 

recognize that their digital presence is often the first touchpoint with customers. The rise of AI-

assisted design tools hasn't replaced human designers but rather elevated expectations for what 

makes a truly exceptional website. Companies are investing more in distinctive web experiences 

that blend aesthetics with functionality, and they're looking for designers who can create 

interfaces that not only look stunning but also drive conversions, accommodate diverse 

accessibility needs, and adapt across an ever-expanding ecosystem of devices. 

19 must-have web designer skills 

Here's a list of 20 skills to help you become a design expert, no matter where you're at in your 

career. 

Creative & technical skills 

1. Visual design principles 

You don't need to know music theory to write a song. If you've never taken an art class, 

you can still draw. Some of us might have an innate artistic ability, but knowing the basic 

fundamentals can make the difference between recreating what you see and being able to build a 

design that's calculated and unique. Our guide to visual design principles explores concepts 

rooted in Gestalt psychology like proximity, similarity, and figure-ground relationships. These 

fundamentals form the backbone of effective web and graphic design and are essential for 

creating intentional, cohesive experiences. 

2. Typography 

Typography shapes our perception of ideas. A type’s weight and geometry communicates 

meaning, and as a designer, it's important to know the best way to deliver messaging with the 

appropriate typographical choices. 

All the font options can make it hard for new designers to know what to choose. For body copy, 

try practical fonts like: 

 Georgia 

 Verdana 

 Roboto 

https://webflow.com/blog/ai-design-tools
https://webflow.com/blog/ai-design-tools
https://webflow.com/blog/essential-visual-design-principles-for-web-designers


Meanwhile, more decorative typefaces should be used sparingly as ornamentation. Good 

designers know the difference between type styles, and where to use them. There are plenty of 

resources on the web to help broaden your typographic knowledge. FONTS IN USE shows 

different typefaces applied to a variety of media. Check out our guide to web typography best 

practices and tips for effective font pairing to elevate your typographic designs and create more 

cohesive visual experiences. 

3. Composition 

The arrangement of text, visuals, and other elements serve both an artistic and utilitarian 

purpose. There's the visual harmony of a design and the organization and hierarchy of ideas. 

Important content should grab our attention and look great. A well-composed layout involves 

creating balance with contrast, negative space, and proportioned elements. Pay attention to 

design around you — websites, paintings, movie scenes, billboards. The more you're aware of 

and can recognize good composition, the more it'll show up in your own design. 

4. Color theory 

Understanding fundamental color principles — such as how primary colors blend to 

create secondary and tertiary hues — will empower you to build harmonious and intentional 

color schemes for your web projects. 

As a designer, you should develop fluency with the color wheel and understand the 

psychological impact of various color relationships: 

 complementary, 

 contrasting, 

 analogous 

The use of clashing colors is a common mistake that plagues beginner designers. A bit of visual 

dissonance can help make for an interesting design, but conflicting hues can also render a layout 

unreadable. Text, calls to action, and headers should use colors that work well together and 

maintain a strong sense of legibility. Understanding and knowing when to use lights and darks, 

contrast, and saturation are also important color skills in website design. 

5. Design tools 

Proficiency with these industry-standard design tools is essential for today's web designers: 

 Adobe Creative Cloud (Illustrator, Photoshop, XD) 

 Figma 

https://fontsinuse.com/
https://webflow.com/blog/typographic-design
https://webflow.com/blog/typographic-design
https://webflow.com/blog/font-pairing
https://webflow.com/blog/color-theory


 Webflow 

 Sketch 

 Framer 

Beyond understanding these platforms, you should develop a solid foundation in photo 

manipulation and vector editing to handle everything from image optimization to logo 

refinements. Budget-conscious designers can leverage powerful free alternatives like Gimp for 

photo editing or Inkscape for vector work without compromising capability. As your skills 

advance, exploring motion design through tools like After Effects or Lottie will help you create 

more dynamic, engaging web experiences that capture attention and enhance user engagement. 

When selecting your primary web creation platform, Webflow offers the ideal balance of design 

flexibility and development power — allowing you to create responsive, professional websites 

without writing code while still maintaining complete creative control over your projects. 

6. Design frameworks & content management systems 

Understanding frameworks and various content management systems is essential for 

modern web designers. A well-designed CMS makes managing large blocks of content 

significantly less burdensome, allowing for efficient updates and organization. For content that 

requires regular refreshing—like blog posts, recipes, or events—a robust CMS will streamline 

the entire process. Using a CMS to link related data and customize templates makes content 

management much more efficient. Many platforms offer built-in CMS features with 

customizable templates that give you the flexibility to create and organize content exactly as you 

need it. 

7. Responsive design 

Responsive design is a key component of the web development process. The guidelines 

for responsive design help guarantee that HTML, CSS (cascading style sheets), and JavaScript 

elements like menus, text, and buttons are clear and usable everywhere. Responsive design 

ensures consistent delivery of your content. It works by having a primary layout that adjusts to fit 

the screen it's loaded on. Making sure your designs translate to different devices helps them 

reach more people without sacrificing the user experience. And with tools like Webflow, you 

don't need to rely on a web developer to bring responsive designs to life. In addition to 

responsive layouts, understanding the fundamentals of accessibility is essential for creating 

inclusive experiences everyone can use. 

https://www.gimp.org/
https://inkscape.org/
https://webflow.com/
https://webflow.com/blog/what-is-a-content-management-system
https://webflow.com/blog/responsive-web-design


8. User experience (UX) 

User experience now encompasses the entire journey a visitor has with your website — 

from their emotional response to the design to how efficiently they accomplish their goals. 

Modern UX blends intuitive usability with thoughtful micro-interactions and personalized 

elements that create memorable digital experiences.  

UX aims to not just guide users through a site, but to anticipate their needs and create moments 

of delight throughout their journey. 

Current UX best practices include: 

 Minimalist layouts with strategic negative space that reduce cognitive load and guide 

attention (prioritize clarity). 

 Inclusive design that considers diverse user needs, abilities, and contexts while 

maintaining a human-centered approach (practice universal empathy). 

 Data-informed personalization that adapts to user behavior and preferences in real time 

(dynamic audience understanding). 

9. User Interface (UI) 

Where UX is concerned more with broad aspects of how a design affects someone, UI 

focuses on specificity. Web pages, buttons, menus, and micro-interactions are all a part of UI. 

These elements guide an audience through a design, free from obstructions, for a smooth 

experience. Today, designers must be fluent in creating interfaces across an expanding 

ecosystem — from traditional screens to voice interfaces, AR overlays, and even haptic feedback 

systems. 

UI touches many different facets of usability including: 

 Navigational elements and straightforward, intuitive interfaces that adapt to context 

(whether on a smartwatch, foldable device, or ambient display). 

 Calls to action that guide people to do what you want them to do in the shortest amount 

of time,with considerations for different input methods. 

 Intuitive and repeatable interaction patterns your audience can follow and learn when 

using your design, regardless of the device or platform they're engaging with. 

10. Graphic design 

Website and graphic design share a similar creative space. Both involve the artistry of 

crafting visuals. But while web design is a medium where ongoing changes and updates are a 

https://webflow.com/blog/ux-design-process


part of any project, graphic design is about creating visuals with longevity. Designing a website 

or a logo may be different design disciplines, but they're both a part of branding. Graphic design 

skills will round out your skill set, allowing you to create typography, custom illustrations, and 

other types of creative flourishes that enhance your web design work. 

11. Search engine optimization (SEO) 

SEO has evolved beyond just keywords into a fundamental design consideration. 

Understanding search engine optimization principles ensures your beautiful designs actually get 

discovered. Modern SEO blends technical elements (like site structure and page speed) with 

content strategy to create websites that both humans and algorithms appreciate. The most 

effective designers recognize that SEO shouldn't compromise user experience — forced keyword 

stuffing creates clunky, unnatural content that drives visitors away. Instead, aim for a 

harmonious balance where SEO enhances rather than detracts from your design's readability and 

flow. 

12. Emerging technologies 

Staying informed about cutting-edge technologies keeps your design work relevant and 

forward-thinking. From AI-powered design tools to immersive experiences like AR and VR, the 

landscape is constantly evolving. Understanding how technologies like generative AI can 

enhance (not replace) your creative process gives you a competitive edge. Whether it's using AI 

to generate initial concepts, exploring 3D elements, or implementing motion-triggered 

interactions, embracing these innovations allows you to create more dynamic, personalized 

experiences that captivate users and solve problems in novel ways. 

Soft skills 

13. Patience 

Design challenges — from difficult feedback to complex navigation problems to career 

plateaus — all demand patience. This fundamental skill helps you gracefully navigate both 

technical obstacles and professional relationships, and prevent hasty decisions when frustration 

peaks. Step away from your screen when needed; a brief walk or task switch often reveals 

solutions that weren't previously apparent. Patience extends beyond design problems to human 

interactions. While clients bring valuable business expertise, they may not understand design 

terminology. Taking time to explain concepts clearly — sometimes through multiple approaches 

— builds trust and elevates your status from service provider to valued partner. 

https://webflow.com/blog/web-design-principles


14. Collaboration 

Collaboration is the cornerstone of effective web design. Working alongside developers, 

marketers, and clients brings diverse perspectives that strengthen your work, though balancing 

feedback with your creative vision can be challenging. The most successful designers cultivate a 

mindset that values input without becoming too attached to initial concepts. They recognize that 

developers spot technical constraints, marketers understand audience needs, and clients know 

their business objectives better than anyone. 

When advocating for design decisions, balance conviction with openness — articulate 

your rationale with evidence when elements serve clear usability or branding goals, but remain 

genuinely receptive to compromise. True design leadership isn't about "winning" every 

discussion, but facilitating outcomes where everyone's expertise contributes to a superior result 

that serves both user needs and business objectives. This collaborative approach transforms 

potential friction points into opportunities that elevate the final product beyond what any 

individual could create alone. 

Unleash your creativity on the web 

Build completely custom, production-ready websites — or ultra-high-fidelity prototypes 

— without writing a line of code. Only with Webflow. 

15. Time management 

Effective time management is crucial for web designers, especially freelancers and teams 

who must balance multiple projects with competing deadlines. Creating a structured work 

schedule, blocking out focused design time, and using productivity techniques like time-boxing 

or the Pomodoro method can help you maintain momentum while preventing burnout. The key is 

establishing boundaries: knowing when to step away from social media and other distractions 

that fragment your attention and diminish your creative output. 

16. Communication 

People skills are as important as pixel skills. Explaining your vision for a project in a way 

that non-designers understand is essential. Stakeholders can include anyone from the marketing 

department to the founder, and you need to communicate how your design meets project goals. 

Much of design is a solitary pursuit, but it's still important to step outside your creative bubble, 

be an active listener, and share what you're working on. 



17. Strategic business thinking 

Understanding the business context behind every project transforms you from a pixel-

pusher to a strategic partner. Effective web designers don't just create beautiful interfaces—they 

craft solutions that directly support conversion goals, brand positioning, and market 

differentiation. This requires asking probing questions about target audiences, competitive 

landscapes, and success metrics before diving into design work, ensuring your creative decisions 

align with measurable business outcomes. Business acumen also helps you prioritize design 

efforts for maximum impact. Rather than automatically pursuing flashy redesigns, you'll develop 

the analytical mindset to recommend precisely what a situation requires — whether that's 

optimizing the checkout flow to reduce abandonment, improving information architecture to 

boost engagement, or strategically refreshing visual elements to better communicate brand 

values. This discernment not only delivers better results for clients but positions you as an 

invaluable advisor who can translate business challenges into effective design solutions. 

18. Attention to detail 

Exceptional web design emerges from intentional decision-making, not happy accidents. 

Every pixel, interaction, and visual element should be purposeful — from the precise spacing in 

your navigation to the subtle color transitions that guide user attention. This meticulous attention 

to detail creates cohesive experiences where nothing feels arbitrary or disconnected. When you 

approach design with this level of precision, you naturally eliminate superfluous elements that 

don't contribute to your goals. The result is work that feels refined and focused, where each 

component not only looks beautiful but meaningfully advances both user needs and business 

objectives. Remember: in thoughtful design, nothing exists without reason. 

19. Continuous learning 

The web design landscape evolves at lightning speed, with new tools, techniques, and 

best practices emerging constantly. Successful designers cultivate a growth mindset—actively 

seeking out fresh perspectives through design blogs, industry podcasts, and community events 

rather than relying solely on what worked yesterday. This perpetual curiosity helps you stay 

ahead of trends like design systems, accessibility standards, and emerging technologies before 

they become mainstream requirements. Beyond just consuming information, effective 

continuous learning involves deliberate practice and experimentation. Challenge yourself to 

implement one new technique in each project, participate in design challenges that push you 



outside your comfort zone, and regularly analyze innovative websites to reverse-engineer their 

solutions. This active approach to professional development not only expands your technical 

toolkit but also keeps your creative thinking fresh and prevents your work from becoming 

formulaic or dated. 

Practical ways to grow your web designer skills 

Take advantage of free and paid courses 

Online platforms like Coursera, Udemy, and Webflow University offer structured lessons 

to boost your web design knowledge. Start with the basics, then move to advanced techniques at 

your own pace. 

Collaborate with the design community 

Online communities like Webflow Forum, Behance groups, and local meetups are great 

places to find support, exchange feedback, and stay inspired by other designers. 

Test your skills on real or mock projects 

 Redesign a local nonprofit's site to improve clarity and impact. 

 Create a single-page promo site for a community event or product launch. 

 Experiment with a personal portfolio to showcase your best work. 

Web design is more than making great websites 

Web design in 2025 demands a versatile toolkit that spans both technical expertise and 

human qualities. The most successful designers balance visual fundamentals — typography, 

color theory, and spatial relationships — with a deep understanding of user behavior and 

business objectives. These elements don't exist in isolation but work together to create 

experiences that are both beautiful and purposeful. 

The soft skills we've explored elevate your work beyond pixels and code to create 

meaningful connections with clients and users alike. Navigating client feedback sessions doesn't 

just improve your designs; it builds the resilience and empathy that serve you in every aspect of 

life. In this ever-evolving field, being a great designer means continuously learning, staying 

curious, and remembering that behind every screen is a human seeking an experience worth their 

time and attention.  

 

 

 



 

 

 

 

 

 

 

 

 

           

 

 

 

 

 

 

S. No Question (5 Mark) LOCF Mapping 

1. Explain the principles of design in digital media. CO2 PO1 K2 

2. Discuss the steps involved in designing a brochure. CO2 PO1 K2 

3. Analyze the importance of newsletters in 

communication. 

CO4 PO1 K4 

4. Explain the process of video designing and editing. CO2 PO1 K2 

5. Discuss the basics of website design and development. CO2 PO1 K2 

 

S. No Question (8 Mark) LOCF Mapping 

1. Analyze the role of creativity in digital designing. CO4 PO1 K4 

2. Examine the advantages of digital design tools. CO4 PO1 K4 

3. Discuss the importance of visual communication. CO4 PO1 K4 

4. Evaluate the role of multimedia in communication 

design. 

CO5 PO1 K5 

Course Outcomes 

CO1: Explain the principles of design in digital media. 

CO2: Demonstrate the process of creating brochures and newsletters. 

CO3: Analyze the techniques used in video design and editing. 

CO4: Describe the basics of website design. 

CO5: Develop creative digital content using various tools. 

 

Programme Outcome 

PO: To develop students’ creative and technical skills in digital 

design, enabling them to produce effective communication 

materials in academic and professional contexts. 



5. Analyze the impact of digital design in modern 

communication. 

CO5 PO1 K5 
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	 The output unit is formed by attaching the output devices of a computer.
	 The output unit accepts the information from the CPU and displays it in a user-readable form.
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